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IMPORTANT NOTICE 

All statements, technical information, and recommendations in this document which relate to the products supplied 
by Meggitt SA are based on information believed to be reliable, but unless otherwise expressly agreed in writing 

with Meggitt SA the accuracy or completeness of such data is not guaranteed. Before using this product, you must 
evaluate it and determine if it is suitable for your intended application. You should also check our website at 

www.meggittsensing.com/energy for any updates to data sheets, Ex certificates, product drawings, user manuals, 
service bulletins and/or other instructions affecting the product. 

Unless otherwise expressly agreed in writing with Meggitt SA, you assume all risks and liability associated with use 
of the product. Meggitt SA takes no responsibility for any statements related to the product which are not contained 

in a current English language Meggitt SA publication, nor for any statements contained in extracts, summaries, 
translations or any other documents not authored and produced by Meggitt SA. 

The certifications and warranties applicable to the products supplied by Meggitt SA are valid only for new products 
purchased directly from Meggitt SA or from an authorised distributor of Meggitt SA. 

Meggitt SA reserves the right to alter any part of this publication without prior notice. 
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PREFACE 
 

About these release notes 

This document provides important information about the VibroSight® software from Meggitt SA. It is applicable to all 
VibroSight-based condition monitoring systems using the versions of software described by this document, namely: 

• VibroSight software version 7.3.0 
(part numbers (PNRs) software license: 608-001-000-001/Codes 
and software: 609-010-000-001 on physical media (USB device (flash drive/key))). 

This document contains information about changes to the software since the previously released version 
(VibroSight 7.2.x), such as new features and improvements, solved problems and bug fixes, and hardware and 
software compatibility. 

For more general information on the actual software, or the entire machinery protection system (MPS) and/or 
condition monitoring system (CMS), refer to the following Meggitt SA documentation: 

 VibroSight® software data sheet 
        (document reference 660-020-005-227A) 

 Getting started with VibroSight® installation guide 
        (document reference 660-010-006-233A) 

 VibroSight® help 

 VM600Mk2 MPC4Mk2 + IOC4Mk2 machinery protection and condition monitoring module data sheet 
        (document reference 268-121) 

 VM600Mk2 RLC16Mk2 relay module data sheet 
        (document reference 268-125) 

 VM600Mk2 CPUMMk2 + IOCNMk2 rack controller and communications interface module data sheet 
        (document reference 268-135) 

 VM600Mk2/VM600 XMx16 + XIO16T extended condition monitoring modules data sheet 
        (document reference 660-020-010-211A) 

 VibroSight application notes and technical notes. 

 

Users who are familiar with VibroSight may also find it useful to refer to the release notes included in earlier 
versions of the software: 

• VibroSight 7.2.0 (document reference 660-010-013-235A) 

• VibroSight 7.1.0 (document reference 660-010-013-234A) 

• VibroSight 7.0.0 (document reference 660-010-013-233A) 

• VibroSight 6.1.0 (document reference 660-010-013-232A) 
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• VibroSight 6.0.0 (document reference 660-010-013-231A) 

• VibroSight 5.1.0 (document reference 660-010-013-230A) 

• VibroSight 5.0.0 (document reference 660-010-013-229A) 

• VibroSight 4.1.0 (document reference 660-010-013-228A) 

• VibroSight 4.0.0 (document reference 660-010-013-227A) 

• VibroSight 3.8.0 (document reference 660-010-013-226A) 

• VibroSight 3.7.0 (document reference 660-010-013-225A) 

• VibroSight 3.6.0 (document reference 660-010-013-224A) 

• VibroSight 3.5.0 (document reference 660-010-013-223A) 

• VibroSight 3.4.0 (document reference 660-010-013-222A) 

• VibroSight 3.3.0 (document reference 660-010-013-221A) 

• VibroSight 3.2.0 (document reference 660-010-013-220A) 

• VibroSight 3.1.0 (document reference 660-010-013-219A) 

• VibroSight 3.0.0 (document reference 660-010-013-218A) 

• VibroSight 2.12.7 (document reference 660-010-013-217A) 

• VibroSight 2.12.6 (document reference 660-010-013-216A) 

• VibroSight 2.12.5 (document reference 660-010-013-215A) 

• VibroSight 2.12.4 (document reference 660-010-013-214A) 

• VibroSight 2.12.3 (document reference 660-010-013-213A) 

• VibroSight 2.12.2 (document reference 660-010-013-212A) 

• VibroSight 2.12.1 (document reference 660-010-013-211A) 

• VibroSight 2.12.0 (document reference 660-010-013-210A) 

• VibroSight 2.11.6 (document reference 660-010-013-209A) 

• VibroSight 2.11.5 (document reference 660-010-013-208A) 

• VibroSight 2.11.4 (document reference 660-010-013-207A) 

• VibroSight 2.11.3 (document reference 660-010-013-206A) 

• VibroSight 2.11.2 (document reference 660-010-013-205A) 

• VibroSight 2.11.1 (document reference 660-010-013-204A) 

• VibroSight 2.11.0 (document reference 660-010-013-203A) 

• VibroSight 2.10.1 (document reference 660-010-013-201A) 

• VibroSight 2.10.0 (document reference VIBROSIGHT-RN/E) 
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• VibroSight 2.9.7 (document reference VIBROSIGHT-RN/E) 

• VibroSight 2.9.6 (document reference VIBROSIGHT-RN/E) 

• VibroSight 2.9.5 (document reference VIBROSIGHT-RN/E) 

• VibroSight 2.9.4 (document reference VIBROSIGHT-RN/E) 

• VibroSight 2.9.2 (document reference VIBROSIGHT-RN/E) 

• VibroSight 2.9.1 (document reference VIBROSIGHT-RN/E). 

 

Use of the release notes 

You should read those sections that are most relevant to you and then keep the document for future reference. 

 

Version identifiers 

A complete VibroSight software version number has four components that provide the following information: 

• x.x.x.x, major release identifier – typically incremented once per year. 

• x.x.x.x, minor release identifier – incremented for each release with typically four scheduled releases per year. 

• x.x.x.x, “hotfix” release identifier – 0 for a normally scheduled release and incremented for each hotfix release. 

• x.x.x.x, software build number – for internal use. 

For each scheduled release of VibroSight, at least one of the first two digits changes (x.x.x.x). 
For unscheduled “hotfix” releases, which are occasionally required to solve urgent problems, the third digit changes 
(x.x.x.x). 

The version identifiers for installed software appear in the Help About box (obtained using Help > About … in any 
VibroSight software module). 
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Terminology 

To distinguish between the different Meggitt SA products that can be used with the VibroSight® software, the 
following terminology is used in this document: 

 

• VM600Mk2/VM600 modules/card(s) – to refer to VibroSight compatible cards that are installed in a 
VM600Mk2/VM600 rack (that is, the first generation of VM600 systems). 

The currently available VM600Mk2/VM600 modules/cards that are designed for operation with the VibroSight 
software are the XMx16 card pairs (XMC16 / XIO16T, XMV16 / XIO16T and XMVS16 / XIO16T) and the 
CPUx card pairs (CPUR2/IOCR2 and CPUR/IOCR). 

Note: It is important to note that VibroSight Configurator is still used for the configuration of these 
VM600Mk2/VM600 modules/cards/systems. 

Where XMx16 is used in this document, it refers to XMC16 / XIO16T, XMV16 / XIO16T and XMVS16 / XIO16T 
cards, unless otherwise stated. 

Where CPUx is used in this document, it refers to CPUR2/IOCR2 and CPUR/IOCR cards, unless otherwise 
stated. 

 

• VM600Mk2 module(s) – to refer to VibroSight compatible modules that are installed in a VM600Mk2 rack (that is, 
the second generation of VM600 systems). 

The currently available VM600Mk2 modules that are designed for operation with the VibroSight software are the 
MPC4Mk2 + IOC4Mk2 machinery protection and condition monitoring module (standard and SIL versions), the 
RLC16Mk2 relay module and the CPUMMk2 + IOCNMk2 rack controller and communications interface module. 

Note: It is important to note that VibroSight Protect is used for the configuration of VM600Mk2 modules/systems. 

 

• VibroSmart® module(s) or VibroSmart® device(s) – to refer to VibroSight compatible VibroSmart modules or 
devices that are used in a VibroSmart distributed monitoring system. The currently available VibroSmart 
modules and devices that are designed for operation with the VibroSight software are the VSI010, VSN010 and 
VSV30x. 

Where VibroSmart module is used in this document, it refers to the VSI010 and VSV30x modules, unless 
otherwise stated. 

Where VibroSmart device is used in this document, it can refer to the VSN010 device only, or to the VSI010 
and VSV30x modules and the VSN010 device, unless otherwise stated. 

Where VSV30x is used in this document, it refers to VSV301 and VSV300 modules, unless otherwise stated. 
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1 Licensing 

Since VibroSight 4.0.0, the ability to install and run VibroSight software updates and upgrades depends on the 
purchased “Updates and support” package. 

NOTE: VibroSight 7.3.0 is a minor level release and a new license key file is not required 
for updates and upgrades from VibroSight 7.x.x. 

However, a new license key file is required for updates and upgrades from 
VibroSight 3.8.x or earlier. 

 
For further information on licensing or to obtain a new VibroSight license key file, contact Meggitt SA customer 
support. See 8 Customer support. 

 

2 Features 

General 

2.1 Support for VM600Mk2 SIL – for critical safety-related applications 

VibroSight 7.3.0 introduces initial support for SIL versions of the VM600Mk2 modules, namely: 

• MPC4Mk2 + IOC4Mk2 SIL machinery protection and condition monitoring module. 

• RLC16Mk2 SIL relay module. 

 

These new SIL versions of the VM600Mk2 modules with their SIL-specific firmware have been designed and 
optimised for use in critical safety-related applications (functional-safety contexts), where the costs of failure are 
high and the highest levels of machinery protection are required. 

 

NOTE: The current SIL versions of the VM600Mk2 modules are “beta” versions for test and 
evaluation only. 
It is important to be aware that the SIL certification process is ongoing and SIL 
certification is pending, so the MPC4Mk2 module cannot be Locked (that is, 
cannot be put into the safety/secure operating mode (of the Operational mode)). 
Accordingly, firmware upgrades to final versions of SIL-specific firmware will be 
required before a VM600Mk2 SIL system containing MPC4Mk2 + IOC4Mk2 SIL 
modules is used in a critical safety-related application. 

 
Please note that these new SIL versions of the VM600Mk2 modules and their SIL-specific firmware are separate and 
distinct to the standard versions of the modules that have been available for some time, namely, the MPC4Mk2 + 
IOC4Mk2 machinery protection and condition monitoring module and the RLC16Mk2 relay module. 
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Different versions of the VM600Mk2 modules: standard and SIL 

The MPC4Mk2 + IOC4Mk2 machinery protection and condition monitoring module and the RLC16Mk2 relay module are 
now available in different versions – standard and SIL – as follows: 

• MPC4Mk2 + IOC4Mk2 and RLC16Mk2 – these are the standard versions of the modules, suitable for most 
applications. 
Note: PNRs 601-041 for the MPC4Mk2, 600-043 for the IOC4Mk2 and 600-045 for the RLC16Mk2. 

• MPC4Mk2 + IOC4Mk2 SIL and RLC16Mk2 SIL – these are the SIL safety versions of the modules, suitable for 
critical applications demanding the highest level of protection. 
Note: PNRs 601-040 for the MPC4Mk2 SIL, 600-042 for the IOC4Mk2 SIL and 600-044 for the RLC16Mk2 SIL. 

 

The MPC4Mk2 + IOC4Mk2 and RLC16Mk2 (standard) are the original versions of the modules and support all features 
and processing functions. 

The MPC4Mk2 + IOC4Mk2 SIL and RLC16Mk2 SIL are versions of the module optimised for use in safety-related 
applications (functional-safety contexts). Accordingly, they have been designed in accordance with the IEC 61508 
“functional safety” standard and will be certified as SIL 2 capable by design (pending). 

In general, the MPC4Mk2 + IOC4Mk2 SIL and RLC16Mk2 SIL modules support the same signal processing functions 
and measurements as the MPC4Mk2 + IOC4Mk2 and RLC16Mk2 (standard) modules but SIL versions of modules are 
visually distinct and feature some important differences in order to meet the strict requirements of SIL safety 
systems. 

For example, the MPC4Mk2 SIL module uses three electronics processing modules in order to help ensure that 
measurements can always be trusted (compared to one processing module for the MPC4Mk2 (standard) module). 
The MPC4Mk2 SIL also completely separates machinery protection system (MPS) and condition monitoring system 
(CMS) functionality so that the safety function is never compromised, as well as implementing more comprehensive 
diagnostics. 

A more detailed comparison of the different versions of the VM600Mk2 modules is given in the table below. 
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Different versions of the VM600Mk2 modules 

Standard versions: 
MPC4Mk2 + IOC4Mk2 and RLC16Mk2 

SIL versions: 
MPC4Mk2 + IOC4Mk2 SIL and RLC16Mk2 SIL 

 
Aluminium (silver) front panels 

(MPC4Mk2 + IOC4Mk2, RLC16Mk2) 
Yellow/orange front panels with “SIL Safety” labelling 

(MPC4Mk2 + IOC4Mk2 SIL, RLC16Mk2 SIL) 
 

One electronics processing module on MPC4Mk2 for all 
functionality (measurements, management and interfacing) 

Three electronics processing modules on MPC4Mk2 SIL: 
• 2 × processing modules for measurements 

(with measurement redundancy with cross-checking) 
• 1 × processing module for management and interfacing 

Separation (firmware only) of 
machinery protection system (MPS) and 

condition monitoring system (CMS) 
functionality/processing on the MPC4Mk2 module 

Complete separation (hardware and firmware) of 
machinery protection system (MPS) and 

condition monitoring system (CMS) 
functionality/processing on the MPC4Mk2 module 

MPC4Mk2 + IOC4Mk2 module only runs diagnostics MPC4Mk2 + IOC4Mk2 SIL module and RLC16Mk2 SIL module 
both run diagnostics 

 

Up to 2 × tachometer (speed) channels 1 × tachometer (speed) channel only 

Tachometer (speed) channel signals can be freely 
shared via the VM600 rack’s Tacho bus. 

Note: MPC4Mk2 + IOC4Mk2 module can put signals on 
and take signals from the Tacho bus. 

Tachometer (speed) channel signals cannot be as freely 
shared via the VM600 rack’s Tacho bus. 

Note: MPC4Mk2 + IOC4Mk2 SIL module can put signals on 
but cannot take signals from the Tacho bus. 

 

Digital high-pass filter (HPF) cutoff frequency up to 15 kHz Digital high-pass filter (HPF) cutoff frequency up to 400 Hz 

 
Up to 4 × user-configurable relays (RL1 to RL4) and 

1 × common circuit-fault relay (FAULT). 
Note: In standard applications, use of the FAULT relay is 

optional. 

Up to 4 × user-configurable relays (RL1 to RL4) and 
1 × common circuit-fault relay (FAULT). 

Note: In safety-related applications, use of the FAULT relay 
is mandatory. 

Up to 16 × user-configurable relays (RL1 to RL16) per additional RLC16Mk2 module 

User-configurable relays can be configured as 
normally energized (NE) or normally de-energized (NDE), 

and as latched or not latched 

User-configurable relays must be configured as 
normally energized (NE), 

and as latched 

Alarms can be configured as latched or not latched Alarms must be configured as latched 

 

Machinery is protected when the MPC4Mk2 module’s 
operational mode is Locked or Unlocked 

Machinery is protected only when the MPC4Mk2 SIL 
module’s operational mode is Locked. 

Note: In safety-related applications, a MPC4Mk2 SIL module 
can only run in the Locked operational mode. 
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System (MPC4Mk2 + IOC4Mk2 module and any RLC16Mk2 
modules) does not enter the safe state (fail-safe mode) if an 

input channel saturates 

System (MPC4Mk2 SIL + IOC4Mk2 SIL module and an 
RLC16Mk2 SIL module) enters the safe state (fail-safe 

mode) if an input channel saturates for more than 1 hour 
 

Live insertion and removal of modules (hot-swapping) with 
automatic reconfiguration is permitted. 

That is, a replaced MPC4Mk2 module will be auto-configured 
by its associated IOC4Mk2 module. 

Live insertion and removal of modules (hot-swapping) with 
automatic reconfiguration is not permitted. 

That is, a replaced MPC4Mk2 SIL module will not be 
auto-configured by its associated IOC4Mk2 SIL module. 

 

Verification of MPC4Mk2 module’s serial number by the 
VibroSight® software 

Verification of MPC4Mk2 + IOC4Mk2 SIL module’s serial 
numbers by the VibroSight® software 

Protection configuration signature not required Protection configuration signature 
(SIL system signature) required 

Enforcing of VM600Mk2 system (MPC4Mk2 + IOC4Mk2 
and RLC16Mk2) configuration rules by the 

VibroSight® software 

Enforcing of VM600Mk2 SIL system (MPC4Mk2 + IOC4Mk2 SIL 
and RLC16Mk2 SIL) configuration rules by the 

VibroSight® software 
 

Notes 
For standard applications, a VM600Mk2 system consists of only standard versions of modules: MPC4Mk2 + IOC4Mk2 
modules and optional RLC16Mk2 modules. A CPUMMk2 + IOCNMk2 rack controller and communications interface module 
can also be used in such systems. 
For safety-related applications (functional-safety contexts), a VM600Mk2 system consists of only SIL versions of modules: 
MPC4Mk2 + IOC4Mk2 SIL modules and optional RLC16Mk2 SIL modules. 
Standard versions of VM600Mk2 modules must be used with other standard VM600Mk2 modules, while VM600Mk2 SIL 
modules must be used with other VM600Mk2 SIL modules. More specifically, VM600Mk2 modules and VM600Mk2 SIL 
modules are not compatible, for example, it is not possible to use a MPC4Mk2 module with a IOC4Mk2 SIL module, and 
vice versa. 
A VM600Mk2 SIL system (MPC4Mk2 + IOC4Mk2 SIL) allows 1 × tachometer (speed) channel only since both auxiliary 
channel inputs must be configured and used to provide a single redundant tachometer input in safety-related 
applications (functional-safety contexts). 
A VM600Mk2 SIL system (MPC4Mk2 + IOC4Mk2 SIL and an optional RLC16Mk2 SIL) will enter the safe state (fail-safe 
mode) whenever the module diagnostics (built-in self-test (BIST)) detects an issue that prevents normal operation, for 
example, hardware faults/problems, significant differences in the measurements from the redundant electronics 
processing modules, etc. 
In the safe state (fail-safe mode), the MPC4Mk2 SIL module activates the system-wide VM600Mk2 system safety-line 
control signal in order to automatically drive all system relays and analog outputs to a safe state. The MPC4Mk2 SIL 
module also activates its status relay (common circuit-fault relay (FAULT) relay) in order to allow issues to be remotely 
detected/indicated. Front-panel LEDS are used for local indication. 
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Accordingly, it is important to be able to identify the different versions of the VM600Mk2 modules that are now 
available: 

• The front panels of the SIL versions of the VM600Mk2 modules use a yellow/orange colour and “SIL Safety” 
labelling.  
Note: In comparison, the front panels of the standard versions of the VM600Mk2 modules have a bare 
aluminium (silver) colour with no “SIL Safety” labelling. 

• In the VibroSight Software, the SIL versions of the VM600Mk2 modules are referred to as MPC4 SIL 
(+ IOC4 SIL) and RLC16 SIL. 
Note: In comparison, the standard versions of the VM600Mk2 modules are referred to as MPC4 (+ IOC4) and 
RLC16. 

 

Configuring VM600Mk2 MPC4Mk2 + IOC4Mk2 SIL and RLC16Mk2 modules 

In VibroSight Protect, configuring a VM600Mk2 SIL system is very similar to configuring a standard VM600Mk2 
system. However, there are a few differences for VM600Mk2 SIL systems, as follows: 

• On the Layout tab/page, when adding modules to a VM600Mk2/VM600 rack, only SIL versions of the VM600Mk2 
modules should be used, that is, MPC4 SIL (+ IOC4 SIL) and RLC16 SIL. 

• On the Configure tab/page, when configuring a MPC4Mk2 SIL (MPC4 SIL) module, the serial numbers of both 
the MPC4 SIL module and the corresponding IOC4 SIL module must be specified. 
Note: In comparison, when configuring a MPC4Mk2 module, only the serial number for the MPC4 module must 
be specified. 

• On the Configure tab/page, when configuring a MPC4Mk2 SIL (MPC4 SIL) module, the 
Watch RLC16 relay status control is always enabled/selected, that is, a MPC4Mk2 SIL module must monitor the 
status of the relays on an associated RLC16Mk2 module, if used. 
Note: In comparison, when configuring a MPC4Mk2 (MPC4) module, monitoring the status of the relays on an 
associated RLC16Mk2 module is optional. That is, the Watch RLC16 relay status control is not used by default 
but can be enabled/selected, as required. 

• On the Configure tab/page, when configuring a MPC4Mk2 SIL (MPC4 SIL) module, if the first auxiliary channel 
(AX1) is configured as a tachometer (speed) channel, then the second auxiliary channel (AX2) is no longer 
available (that is, both auxiliary channel inputs must be configured and used to provide a single redundant 
tachometer input in safety-related applications (functional-safety contexts), so after Auxiliary 1 is configured as 
a tachometer, Auxiliary 2 becomes unavailable/hidden as it is being used in the background). 

• On the Configure tab/page, when configuring a MPC4Mk2 SIL (MPC4 SIL) module, the Fault relay is selected by 
default, that is, a MPC4Mk2 SIL module’s fault relay must always be used, although the input to the fault relay 
can be configured as one of either: A failure in the MPC4 card or the VM600 power supply (the default) or  
A failure in the MPC4 card or the sensor chains or the VM600 power supply. 
Note: In comparison, when configuring a MPC4Mk2 (MPC4) module, use of the MPC4Mk2 SIL module’s fault 
relay is optional. That is, the Fault relay is not used by default but can be enabled/selected and configured as 
required by the user. 

• When configuring a RLC16Mk2 SIL (RLC16 SIL) module, there are no Logical functions on the relay module. 
Only Logical functions on MPC4Mk2 SIL (MPC4 SIL) modules can be used in a VM600Mk2 SIL system. 



 

RELEASE NOTES 
VibroSight® 7.3.0 
16 / 81 

Document reference VIBROSIGHT-RN/E (660-010-013-236A) 
Version 36 – 01.06.2023 

 

Note: In comparison, when configuring a RLC16Mk2 (RLC16) module, there are Logical functions on the relay 
module that can be configured as required by the user. 

 

NOTE: When configuring a VM600Mk2 SIL (or standard) system, the Consistency checks 
window (bottom) should be used to help detect and correct any configuration errors 
in order to help ensure that the configuration is correct and valid. 

 
 
Activating a VM600Mk2 SIL system 

In VibroSight Protect, activating a VM600Mk2 SIL system is very similar to activating a standard VM600Mk2 system.  

To activate a configuration, either the File > System activation menu command or the Activate control (under 
Module status) on the Dashboard tab/page can be used. 

Then, after the Activate configuration window checks the system status and warns the user that the machinery 
protection function will temporarily interrupted, click Proceed to continue. 

The configuration will be downloaded to the VM600Mk2 SIL system and start running – with measurement, status 
and control information displayed on the Dashboard tab/page. 

 

However, there are a few important differences for VM600Mk2 SIL systems, as follows: 

• When the configuration is activated and initially starts running on a VM600Mk2 SIL system, the MPC4Mk2 SIL 
(MPC4 SIL) module status is Unlocked but must be changed to Locked in order to be SIL compliant! 
Note: On the Dashboard tab/page, under Module status in the main window (right), Running Unlocked is 
displayed and the LOCK/SAFE LED on the front panel of the module is red. 

• To change a MPC4Mk2 SIL (MPC4 SIL) module status to Locked, either the Lock card control on the Dashboard 
tab/page can be used or button 2 (right) on the front panel of the module can be pressed and held for at least 
1 s. 

• Before a MPC4Mk2 SIL (MPC4 SIL) module can be Locked, it’s configuration (more specifically, a SIL machine 
protection configuration) must be signed! This is necessary in order to help ensure that any changes to a SIL 
system are authorised and that there is traceability of the changes made to a SIL configuration. 
Note: On the Dashboard tab/page, under Module status in the main window (right), Machinery protection 
configuration not signed is displayed and the LOCK/SAFE LED on the front panel of the module is red. 

 

Signing a VM600Mk2 SIL system configuration 

In VibroSight Protect, a VM600Mk2 SIL system configuration must be signed – as proof of approval – before the 
VM600Mk2 SIL system can be Locked and thereby run as a SIL compliant system! 

To sign a configuration, the configuration must first be downloaded to the VM600Mk2 SIL system, then either the 
File > SIL system signature menu command or the Sign control (under Module status) on the Dashboard tab/page 
can be used. 
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Then, the Sign SIL system window will download the configuration from the MPC4Mk2 SIL (MPC4 SIL) module and 
display it in a human-readable format that allows it to be checked/verified. Note that a CRC32 check value code 
that uniquely identifies the SIL configuration is also calculated and displayed. 

When the user is happy with the configuration, they can enter their identifier/signature (Signatory) and click 
Sign configuration (bottom right). The VibroSight software will then attach a digital signature, with a timestamp, to 
the SIL configuration that is stored on the module. Click Close to continue. 
Note: On the Dashboard tab/page, under Module status in the main window (right), Machinery protection 
configuration signed by … is now displayed and the LOCK/SAFE LED on the front panel of the module is red. 

 

Once the VM600Mk2 SIL system configuration has been signed, the system can now be Locked in order to run as a 
SIL compliant system! 

To lock a system (MPC4Mk2 SIL (MPC4 SIL) module), either use the Lock card control (under Module status) on the 
Dashboard tab/page or press and hold button 2 (right) on the front panel of the module for at least 1 s. 
Note: On the Dashboard tab/page, under Module status in the main window (right), Running as SIL and Locked are 
displayed and the LOCK/SAFE LED on the front panel of the module is green. 

NOTE: Once a VM600Mk2 SIL system has been locked, it can only be unlocked by pressing 
button 2 (right) on the front panel of the MPC4Mk2 SIL (MPC4 SIL) module 5 times 
within 5 s. 
More specifically, physical access to the MPC4Mk2 SIL (MPC4 SIL) module, front of 
VM600Mk2/VM600 rack, is required to unlock a VM600Mk2 SIL system. 

 

 

Finally, there are a few important differences for VM600Mk2 SIL systems that it is important to be aware of, 
as follows: 

• When the configuration is activated and initially starts running on a VM600Mk2 SIL system, the MPC4Mk2 SIL 
(MPC4 SIL) module status is Unlocked but must be changed to Locked in order to be SIL compliant! 
Note: On the Dashboard tab/page, under Module status in the main window (right), Running Unlocked is 
displayed and the LOCK/SAFE LED on the front panel of the module is red. 

• To change a MPC4Mk2 SIL (MPC4 SIL) module status to Locked, either the Lock card control on the Dashboard 
tab/page can be used or button 2 (right) on the front panel of the module can be pressed and held for at least 
1 s. 

• Before a MPC4Mk2 SIL (MPC4 SIL) module can be Locked, it’s configuration (more specifically, a SIL machine 
protection configuration) must be signed! This is necessary in order to help ensure that any changes to a SIL 
system are authorised and that there is traceability of the changes made to a SIL configuration. 
Note: On the Dashboard tab/page, under Module status in the main window (right), Machinery protection 
configuration not signed is displayed and the LOCK/SAFE LED on the front panel of the module is red. 

 

See also the “Different versions of the VM600Mk2 modules” table starting on page 12. 
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2.2 VM600Mk2 MPC4Mk2 support for magnetic flux monitoring and analysis 

VibroSight 7.3.0 and the VM600Mk2 MPC4Mk2 improve the monitoring of hydro machinery with the addition of 
support for magnetic-flux monitoring and analysis by the ‘Hydro air-gap monitoring’ application specific package. 

(Previously, VibroSight 7.2.0 and the VM600Mk2 MPC4Mk2 with the Hydro air-gap monitoring package supported air-
gap monitoring and analysis only.) 

NOTE: The VibroSight “Hydro air-gap monitoring” package allows the air gap between 
rotor and stator, and the rotor and stator shapes (geometrical data) to be monitored 
for hydroelectric generators. It also allows the magnetic flux (magnetic flux density, 
also known as magnetic field strength) of the air gap to be monitored. 

 

It is important to note that the base/standard edition of the VibroSight software (that is, VibroSight Classic) includes 
the Hydro air-gap monitoring package in addition to providing full support for vibration analysis, including a 
complete catalogue of plots and the functionality required for the display and analysis of absolute vibration, relative 
vibration, position, displacement, eccentricity expansion and so on. 

 

Magnetic-flux monitoring involves measuring the magnetic flux density, also known as magnetic field strength, in 
the air gap (that is, the radial distance) between the poles of a rotating rotor inside a stator bore of a hydroelectric 
generator. Magnetic-flux monitoring and analysis can help determine if shorts have occurred in the windings of the 
rotor poles and complements air-gap monitoring to achieve a more comprehensive monitoring solution for larger 
hydroelectric machinery. 

For a generator, magnetic flux is a radial measurement (like air gap) that is detected by means of a magnetic flux 
sensor that is installed on the stator. As each rotor pole sweeps by the magnetic flux sensor, a voltage is induced in 
the sensor that is proportional to the change in magnetic flux from the pole that is passing the probe. Shorted 
windings in the rotor will cause a change in the magnetic flux profile within a pole at a given load. 

In general, to monitor the magnetic flux, one magnetic flux sensor (probe) is mounted on the stator, on a horizontal 
plane for a vertical axis machine. 

 

To use the Hydro air-gap monitoring package with magnetic-flux monitoring 

• VibroSight Protect is used to configure the VM600Mk2 monitoring system for the magnetic flux 
sensor/measurement chain being used. 
Note: No magnetic flux processing can be configured in VibroSight Protect as magnetic flux measurements are 
not applicable to machinery protection. 

• VibroSight Capture is used to configure the VM600Mk2 monitoring system for the magnetic flux 
sensor/measurement chain being used. 
Note: Magnetic flux processing is configured in VibroSight Capture as magnetic flux measurements are 
applicable to condition monitoring. 

• VibroSight Vision is used to display the resultant magnetic-flux measurements using the existing VibroSight 
Vision plots. 
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VibroSight Protect 

With VibroSight 7.3.0, VibroSight Protect now allows VM600Mk2 MPC4Mk2 dynamic channels (CH1-CH4) to be 
configured for use with magnetic flux sensors and magnetic flux processing functions. 

In VibroSight Protect, when configuring a dynamic channel for use with magnetic flux sensors, select Processing 
type: Single, Sensor family: Magnetic flux sensors, then the Magnetic flux processing function. 

Then, when prompted to configure the sensor / measurement chain (Configuration of a channel), under the Library 
list, use the Add > Add generic sensor chain control to add a magnetic flux sensor (note: vibro-meter does not 
produce magnetic flux sensors). 

When configuring a magnetic flux sensor / measurement chain: 

• The sensor (sensitivity) can be configured as Magnetic flux (T) or Magnetic flux variation (T/s). 
For Magnetic flux variation (T/s) sensors, an integration is automatically performed in order to provide a 
Magnetic flux (T) output. 

• The sensor output signal (sensitivity) can be configured as current or voltage. 

• The sensor output type must be configured Dynamic (that is, Quasi-static magnetic flux sensors are not 
supported). 

(VibroSight Protect configures MPC4Mk2 module magnetic flux sensors / measurement chains to use AC + DC 
signal coupling, as per air-gap sensors / measurement chains.) 

 

VibroSight Capture 

With VibroSight 7.3.0, VibroSight Capture now allows VM600Mk2 MPC4Mk2 magnetic flux channels and 
measurements to be configured for condition monitoring. 

In VibroSight Capture, the Machinery tab/page is used to create a machine train to which magnetic flux 
channels/measurements can be added. That is, to the Machinery component: Generator, Large. 

The Systems tab/page is used to import the VibroSight Protect configuration containing magnetic flux sensors / 
measurement chains. 

The Connect tab/page is used to establish the connections (links) between the machine train components 
(Generator, Large) and the magnetic flux measurements (VibroSight Protect configuration). 

NOTE: It is important to note that a magnetic flux sensor is general for an entire generator 
and is not related to any specific layer. 

 

The Configure tab/page is used to configure the magnetic flux measurements for condition monitoring. That is, the 
System tab (right) allows modules and measurement channels (left) to be selected and configured. 
For example, with a magnetic flux measurement channel selected (left), the Processing tab (right) allows the 
configuration of magnetic flux waveforms such as Flux shape and Flux signature, and measurements such as 
Min flux, Max flux, Avg flux and THD. 

The Data tab/page is used to configure data management for magnetic flux measurements as usual, such as 
data logging and diagnostics. 
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Configuration is now complete but VibroSight Capture must be saved as a Server before it can be used.  

Since VibroSight implements the Hydro air-gap monitoring package as post-processing at the VibroSight Server 
level (that is, the VibroSight Server’s Air gap and flux processing), once the VibroSight Server is running, the 
required processing (Server feature) must be enabled: 

 

VibroSight Server 

On the Status tab, under Device drivers, ensure that the monitoring system (MPC4 and/or MPC4 SIL) is enabled. 

On the Status tab, under Server features, ensure that Air-gap is enabled. 

 

VibroSight Vison 

To display hydro air-gap monitoring measurements using VibroSight Vision: 

VibroSight Vision is used to display hydro air-gap monitoring measurements, including magnetic flux waveform and 
measurement data in the usual way: 

• Using the Machinery view or Hardware view to select the measurement or measurements to display. 

• Using the Time Range to select historical or live data (and the time period of interest for historical data). 

 

The usual VibroSight Vision plot types are used to display hydro air-gap and magnetic-flux monitoring 
measurements. For example: 

• Bar Chart plots, Bode plots, Table plots and Trend plots can be used to display scalar “pole data” such as 
gaps and circularities, and vector “pole data” such as eccentricities and ellipticities. 

Typically, Bar Chart plots, Bode plots, Table plots and Trend plots display Airgap (amplitude) and additional 
pole information is automatically included in the plot legend. 

• Waveform plots can be used to display “waveform” and “rotor data” such as rotor shapes, rotor signatures, 
layer rotor signatures and layer stator shapes. For “rotor data”, a constructed waveform is displayed where 
every pole is a constant amplitude value (the value measured for that pole). 

The Waveform plot’s x-axis can be configured as Time, Revolutions or Poles, as required, and additional gap 
information is automatically included in the plot legend. 

• Polar Waveform plots can be used to display “waveform” and “rotor data” such as rotor shapes, rotor 
signatures, layer rotor signatures and layer stator shapes. For “rotor data”, a constructed waveform is 
displayed where every pole is a constant amplitude value (the value measured for that pole). 

When displaying any gap related curve, the amplitude axis is automatically reversed so that the amplitude 
decreases radially going from the centre of the plot outwards. A gap related curve is plotted as a best-fit 
circle with a corresponding centre marker: “+” for rotor-related curves and “x” for stator-related curves. The 
centre marker and the curve will be the same colour. 

The Polar Waveform plot’s x-axis can be configured as Angle or Poles, as required, and additional gap, 
circularity, eccentricity and ellipticity automatically included is included in the plot legend. 
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2.3 VibroSight Vision and Trend plot curve colour behaviour 

In VibroSight Vision, for the display of Trend plots, the behaviour of the colours assigned to the curves in a plot has 
been changed such that once the colours have been assigned (whether automatically or by the user), the colours 
will now remain the same (persist) unless they are expressly changed by the user. 

(Previously, for Trend plots, if the mode (Time/Speed) of the x-axis of the plot or the Time Range was changed, 
then the default colours were automatically reassigned to the curves in the plot.) 

For example, the Time/APHT vs Speed/Bode control in the plot legend or the X-Axis Quantity: Time vs Speed 
control in the Plot properties (right click > Plot properties) can be used to change the mode (Time/Speed). 

 

2.4 VibroSight Vision plot cursor changes 

In VibroSight Vision, for the display of plots, the display of the cursor has been changed such that for the curve that 
the cursor is currently bound to (that is, the main cursor), the cursor is displayed as a small square marker, while 
for the other curves in the plot, the cursor is displayed as a small round marker (at the currently selected 
measurement data points (timestamp)). 

(Previously, for the display of plots, for the curve that the cursor is currently bound to (that is, the main cursor), the 
cursor was displayed as a small square marker, while for the other curves in the plot, no cursor was displayed.) 

 

In VibroSight Vision, for the display of plots, it is now possible to use only the pointer (mouse) to change the curve 
that the cursor is currently bound to (that is, the main cursor). 

It is simply necessary to CTRL+click on the plot close to a curve and the cursor will automatically be bound to the 
closest curve, as indicated by a small square marker (at the currently selected measurement data points 
(timestamp)). 

Alternatively, in the plot legend, there is a new cursor column (after the colour, Curve and Visible columns), 
indicated by the main cursor symbol, which can be also used to change the curve that the cursor is currently bound 
to – by simply clicking on the appropriate round button control in the cursor column. 

 

Note: As before, it is possible to change the currently bound cursor by using UP ARROW and DOWN ARROW 
keyboard shortcuts (or SHIFT+UP ARROW and SHIFT+DOWN ARROW keys depending on the Vision plot type) to 
rotate through the curves in the order that they are listed in the plot legend. 
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2.5 New VibroSight Mimic indicator 

In VibroSight Mimic, a new indicator has been added in order to allow the display of system information: 

• Machine state indicator – for the display of machine or machine train information, that is, it can be associated 
with a machine or machine train. 
Note: If the node in the Machinery view associated with a machine state indicator is a machine or machine 
train, then it will be associated with the indicator. Otherwise the first machine or machine train ancestor shall be 
associated to the widget. 

 

When VibroSight Mimic is in the Edit mode, the Machine state indicator is available in the Toolbox window that is 
displayed (right). To add an indicator, or any other Mimic control to a Mimic document, drag a control from the 
toolbox to the main document (centre). To associate (link) a machine/system component with a Mimic indicator, 
drag the machine/system component from the Machinery (or Hardware) view (left) to the indicator in the main 
document (centre). To configure the Mimic indicator, use the Properties window that is displayed (right). 

 

2.6 VibroSight Server reuses the same security certificate for OPC UA devices 

VibroSight Server now reuses the same security certificate for an OPC UA device (that is, a VibroSight OPC UA 
client used to import data into VibroSight) after the VibroSight Server restarts in order to reduce the requirement for 
security certificate re-approval on the corresponding OPC UA server, such as a DCS. 

(Previously, VibroSight Server would regenerate a new version of the security certificate after a restart, which could 
require manual intervention on the corresponding OPC UA server (DCS) in order to re-approve a previously 
approved communications link.) 

NOTE: The OPC UA client/server protocol security is based on application certificates, 
whereby each application shall trust each other based on the exchange of signed 
(trusted) certificates. 

 

2.7 OPC UA devices and timestamping 

In VibroSight, when configuring an OPC UA device (that is, a VibroSight OPC UA client used to import data into 
VibroSight), it is now possible to specify different timestamping options on a tag/node group basis, as follows: 

• VibroSight Server timestamp (the default) 

• OPC UA server timestamp 

• OPC UA source timestamp. 

When configuring an OPC UA device in VibroSight Capture (Systems tab/page, OPC UA device) or 
VibroSight Configurator (VibroSight Server configuration, OPC UA device), for each Tag group or OPC UA 
node group respectively, the timestamping control is used to specify the required timestamp option. 

NOTE: The VibroSight Server supports the three timestamping sources but will round the 
timestamps to a maximum precision of 100 ms. 
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2.8 OPC UA devices and UA state groups 

In VibroSight, when configuring an OPC UA device (that is, a VibroSight OPC UA client used to import data into 
VibroSight), it is now possible to specify state groups in addition to the existing support for tag/node groups. 

NOTE: In VibroSight, OPC UA sate groups are used to work with Boolean OPC data. 

 

When configuring an OPC UA device in VibroSight Capture (Systems tab/page, OPC UA device), under State 
groups (left), clicking on the next available State group n control will add a new state group. 

With the state group selected, on the General tab for the state group, there are controls to enable/disable, name 
and describe/document the state group. It is also where the timestamping for the state group is configured. 

On the States tab for the state group, there are controls to add and configure (enable/disable, name, etc.) individual 
states for the state group. An OPC UA node browser dialog is used to make it easier to add the Boolean OPC data 
(nodes). 

 

When configuring an OPC UA device in VibroSight Configurator (VibroSight Server configuration, OPC UA device), 
on the OPC UA device (Harwdare view, right), right-clicking and clicking then clicking New OPC UA states group  
will add a new state group. 

With the state group selected, in the main window (centre) there are controls to name, enable/disable, and 
describe/document the state group. It is also where the timestamping for the state group is configured. 

Right-clicking the state group (Hardware view) and then clicking New Boolean state will add an individual state to 
the state group. With the Boolean state entity selected, in the main window (centre) there are controls to configure 
(enable/disable, name, etc.) the state group. An OPC UA node browser dialog is used to make it easier to add the 
Boolean OPC data (nodes). 

 

Finally, it is important to note that OPC UA state groups data is automatically logged into the VibroSight Server 
database so they not need to be considered/included in any data logging rules. 

 

2.9 VibroSight Vision and OPC UA state groups 

In VibroSight Vision, for a system using OPC UA state groups, nodes corresponding to the OPC UA state groups 
are displayed in the Machinery view (left, top) while the corresponding individual states are displayed under 
Measurements (left, bottom). 

The individual OPC UA states can be added to the following plot types: Trend plot and Long Waveform plot. 

In plots, the states are treated and displayed as any other VibroSight data, using the Boolean values of True (1) 
and False (0). 
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2.10 Redundancy added to VibroSight’s Modbus device TCP/IP driver 

Redundancy has been added to VibroSight’s Modbus device TCP/IP driver in order to improve the reliability of data 
sharing via Modbus TCP. 

Accordingly, in VibroSight Configurator, when configuring a network Modbus device in the Modbus master mode 
(that is, a VibroSight Modbus client used to import data into VibroSight), a Primary connection and an optional 
Fallback connection can now be configured. That is, there is now a separate IP address or host name and port 
number for primary and fallback connections, sharing a common unit ID. 

During operation, the VibroSight network Modbus device will connect using the primary connection by default but 
should this connection (Modbus server) become unavailable, then the VibroSight network Modbus device will 
automatically switch to the fallback connection (Modbus server). Similarly, if the VibroSight network Modbus device 
is connected using the fallback connection and this connection become unavailable, then the VibroSight network 
Modbus device will automatically switch to the primary connection. 

Whenever the VibroSight network Modbus device switches between primary and fallback connections (Modbus 
servers), a message will be displayed by the VibroSight Server (on the Log messages tab). 

 

2.11 VibroSight Protect displays relay information for VM600Mk2 RLC16Mk2 modules 

In VibroSight Protect, the Dashboard tab/page now displays summary configuration and live status information of 
any used (that is, configured) relays for a VM600Mk2 RLC16Mk2 relay module, when the module is selected in the 
System view (right). 

(Previously, the Dashboard tab/page in VibroSight Protect did not display any relay information for VM600Mk2 
RLC16Mk2 modules.) 

 

2.12 VibroSight Protect displays “latched” status information for relays on VM600Mk2 MPC4Mk2 + 
IOC4Mk2 modules and VM600Mk2 RLC16Mk2 modules 

In VibroSight Protect, the Dashboard tab/page now displays the live “latched” status of any used (that is, 
configured) relays for a VM600Mk2 MPC4Mk2 + IOC4Mk2 machinery protection and condition monitoring module and 
for a RLC16Mk2 relay module, when the module is selected in the System view (right). 

(Previously, the Dashboard tab/page in VibroSight Protect did not display the “latched” status information for any 
relays.) 

 

2.13 VibroSight Protect displays analog output information for VM600Mk2 MPC4Mk2 modules 

In VibroSight Protect, the Dashboard tab/page now displays summary configuration and live status information of 
any used (that is, configured) analog outputs for a VM600Mk2 MPC4Mk2 module, when the module is selected in the 
System view (right). 

(Previously, the Dashboard tab/page in VibroSight Protect did not display any analog output information for 
VM600Mk2 MPC4Mk2 modules.) 
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2.14 VibroSight Protect allows the Raw bus to be used for VM600Mk2/VM600 slimline (1U) racks 

In VibroSight Protect, when configuring a VM600Mk2 system in a VM600Mk2/VM600 slimline rack (1U, ABE056), the 
Raw bus is now available for use, for example, via the Bus View of the Layout tab/page. 

(Previously, in VibroSight Protect, the Raw bus was not available for the VM600Mk2/VM600 slimline rack, that is, 
only the Open collector (OC) bus was available.) 

The Raw bus is required so that VM600Mk2 MPC4Mk2 + IOC4Mk2 machinery protection and condition monitoring 
modules can monitor the status of the associated RLC16Mk2 relay module and activate the system-wide 
VM600Mk2 MPS safety-line control signal as required. 

NOTE: The VM600Mk2 MPC4Mk2 + IOC4Mk2 module can use a system-wide VM600Mk2 MPS 
safety-line control signal in fail-safe mode, also known as the “Redline”, in order to 
automatically drive all system relays (IOC4Mk2 and RLC16Mk2) and analog outputs 
(IOC4Mk2) to a safe state. The Redline signal is a line on the VM600Mk2/VM600 Raw 
bus. 

The VM600Mk2 MPC4Mk2 + IOC4Mk2 module can monitor a single status line from an 
associated RLC16Mk2 module, known as the “Status”, in order to know if all of the 
relays on the associated RLC16Mk2 module are operating as expected. The Status 
signal is a line on the VM600Mk2/VM600 Raw bus. 

 

Monitoring of an associated RLC16Mk2 relay module by a MPC4Mk2 module is optional for the standard versions of 
the modules but compulsory for the SIL versions of the modules. In VibroSight Protect, this functionality is 
configured/enforced on the Configure tab/page: when a MPC4Mk2 module is selected, on the General tab, see the 
Watch RLC16 relay status and Watch RLC16 SIL relay status controls respectively. 

 

2.15 VibroSight Protect supports easier configuration of logical functions on VM600Mk2 
RLC16Mk2 modules 

In VibroSight Protect, when configuring a VM600Mk2 system containing RLC16Mk2 relay modules, when configuring 
Logical functions on a RLC16Mk2 module (standard version only), when adding Inputs to a logical function, the 
name of the MPC4Mk2 module and its slot ID are now displayed with the input in order to make it easier to work with 
logical functions on RLC16Mk2 modules. 

NOTE: The VM600Mk2 RLC16Mk2 relay module (standard version) supports logical functions 
and relays. 

The VM600Mk2 RLC16Mk2 SIL relay module supports relays only. 
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2.16 VM600Mk2 MPC4Mk2 not running flag 

For the VM600Mk2 MPC4Mk2 + IOC4Mk2 module, the “MPC4 running” flag has been replaced by a 
“MPC4 not running” flag. That is, the logic behind the MPC4 running flag (status bit) has been inverted. 

This was done in order to be consistent earlier versions of the product, namely the VM600 MPSx software / MPC4 
and IOC4T card, and because it is easier to use a “MPC4 not running” flag. For example, with the 
“MPC4 not running” flag, the signal can be used to drive a normally energized (NE) relay such that the relay will 
become de-energized to indicate that the module is not configured and running normally. 

 

2.17 VM600Mk2 MPC4Mk2 sensor NOK check flag for a channel pair 

For the VM600Mk2 MPC4Mk2 + IOC4Mk2 module, a new “Sensor NOK check” (sensor not OK) flag has been added 
for channel pairs. This new channel-pair “Sensor NOK check” flag (status bit) is the logical OR of the individual 
sensor NOK checks for the channels making up the channel pair, that is channels 1 and 2 for channel pair 1 and 
channels 3 and 4 for channel pair 2. 

The new channel-pair “Sensor NOK check” flags (status bits) are automatically available when the dynamic 
channels of a VM600Mk2 MPC4Mk2 + IOC4Mk2 module have been configured with dual-channel processing functions 
(that is, as channel pairs) and the flags (status bits) can be used when configuring the inputs to logical functions 
and/or relays. 

 

2.18 VM600Mk2 MPC4Mk2 shaft eccentricity processing time decay 

In VibroSight Protect, for a VM600Mk2 MPC4Mk2 module, when configuring Shaft eccentricity processing, it is now 
possible to configure a Decay time for the measurement, if the Calculation method is Continuous (as opposed to 
Per revolution). 

By default, the decay time value for shaft eccentricity processing is 4.7 s but it is user-configurable with a value 
between 0.1 and 60 s. 

 

2.19 VM600Mk2 MPC4Mk2 modules will not restart if their configuration does not change 

In VibroSight Protect, when re-configuring a VM600Mk2 system containing multiple MPC4Mk2 modules, only 
MPC4Mk2 modules whose configuration has changed will restart when the new configuration is activated on the 
system. That is, MPC4Mk2 modules whose configuration has not changed will not restart when the new 
configuration is activated on the system. 
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2.20 Clearing a machinery protection configuration using VibroSight System Manager 

VibroSight System Manager can now be used to clear (delete) the machinery protection configuration on a 
VM600Mk2 MPC4Mk2 module (standard and/or SIL versions). 

(Previously, in order to clear a machinery protection configuration, it was necessary to force the VM600Mk2 
MPC4Mk2 module into the Recovery mode – which automatically erased the module’s complete configuration.) 

In VibroSight System Manager, there is now a new Clear configuration control available in the Action window 
(right). 

NOTE: When the Clear configuration control in VibroSight System Manager is used to 
clear (delete) the machinery protection configuration on a VM600Mk2 MPC4Mk2 
module, both the machinery protection and condition monitoring functionality 
provided by the module will be interrupted!. 

 
Multiple VM600Mk2 MPC4Mk2 modules can be selected (for example, using CTRL-click and/or SHIFT-click) before 
running the Clear configuration command in order to clear the machinery protection configuration on multiple 
modules at the same time. 

A VM600Mk2 MPC4Mk2 module must be Unlocked in order for its machinery protection configuration to be cleared. If 
the module is Locked, then the module’s machinery protection configuration is protected and cannot be changed 
(cleared/deleted). 

 

2.21 VibroSight Protect sensor configuration tool improved 

In VibroSight Protect, the sensor configuration tool used to add new generic sensors / measurement chains to the 
Global sensors catalog has been improved and simplified in order to make it easier to add new sensors / 
measurement chains to VibroSight protect. 

More specifically, the user can add a new sensor / measurement chain by knowing the answers to the following 
three questions: 

• What is the sensitivity? 

• What is the highest value that can be measured? 

• What is the lowest value that can be measured? 

More specifically, it is no longer necessary to enter offsets (in electrical units and engineering units) as these are 
now calculated automatically by VibroSight Protect. 
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VM600Mk2 modules 

2.22 MPC4Mk2 + IOC4Mk2 module – hardware (standard and SIL versions) 

The MPC4Mk2 + IOC4Mk2 machinery protection and condition monitoring module and the RLC16Mk2 relay module are 
now available in different versions – standard and SIL – as follows: 

• MPC4Mk2 + IOC4Mk2 and RLC16Mk2 – these are the standard versions of the modules, suitable for most 
applications. 
Note: PNRs 601-041 for the MPC4Mk2, 600-043 for the IOC4Mk2 and 600-045 for the RLC16Mk2. 

• MPC4Mk2 + IOC4Mk2 SIL and RLC16Mk2 SIL – these are the SIL safety versions of the modules, suitable for 
critical applications demanding the highest level of protection. 
Note: PNRs 601-040 for the MPC4Mk2 SIL, 600-042 for the IOC4Mk2 SIL and 600-044 for the RLC16Mk2 SIL. 

 

See also 2.1 Support for VM600Mk2 SIL – for critical safety-related applications, 2.24 MPC4Mk2 + IOC4Mk2 SIL 
module – firmware and 2.23 MPC4Mk2 + IOC4Mk2 module – firmware. 

 

 

2.23 MPC4Mk2 + IOC4Mk2 module – firmware 

NOTE: Standard versions of firmware are for use with the MPC4Mk2 + IOC4Mk2 module only 
(that is, PNR 601-041 for the MPC4Mk2). 

 

Updated VM600Mk2 MPC4Mk2 + IOC4Mk2 machinery protection and condition monitoring module firmware with the 
following main improvements: 

 

Machinery protection firmware: 640-025-008-000 

NOTE: VM600Mk2 MPC4Mk2 machinery protection firmware (640-025-008-001) is 
compatible with both versions of the MPC4Mk2 module (PNRs 600-041-000-vvv and 
600-041-001-vvv). 

 

Features: 

• Add the possibility to select a “sensor NOK check” for dual channels (1&2 and/or 3&4) as an input to a logical 
function. 

• MPC4Mk2 “running flag” now indicates "Mpc4 not running” in order to be consistent with the behaviour of the 
original (Mk1) MPC4. (Previously, the MPC4Mk2 “running flag” indicated "Mpc4 running”.) 

• Analog output information (value and state) now available from module with voltage and temperature 
information. Note: To access this data, in VibroSight Vision, use Right-click and Show system data. 
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• A Fail-safe due to internal diagnostics (BIST, Error class 2 error-level problem detected) can be cleared by 
activating the DSI Alarm Reset (AR), which will force the module back into the Operational mode. 
Note: This new DSI AR behaviour is equivalent to resetting the module by pressing and holding button 2 (right) 
on the front panel of the module for at least 1 s. 

• Some of the faults detected by internal diagnostics (BIST) that were classed as Error class 1 fatal-level 
problems have been reclassified as Error class 2 error-level problems. This was done so that Error class 1 
fatal-level problems are now reserved for essentially irrecoverable issues that require more serious intervention 
(such as a persistent hardware problem (failure)), as compared to Error class 2 error-level problems that are 
typically resolved by correcting the issue and resetting (booting) the system. 

The Error class 1 diagnostic fault codes reclassified as Error class 2 are: 
o 2: FAULT_TACHO_COMPARATOR_FAILURE 

o 27-30: FAULT_TEST_TONE_DYNx_FAIL 

o 46: FAULT_LOGIC_SPI_COM_ERROR 
o 47: FAULT_OTHER_SVP_NOT_SYNCH 

o 48: FAULT_SVP_RECIPROCAL_FAILURE 

o 50: FAULT_TEMPORAL_MONITORING 
o 53: FAULT_SVP_STATUS_NOT_MATCH 

o 54: FAULT_CYCLE_COUNT_NOT_MONOTONIC 

o 57: FAULT_LOGICAL_MONITORING 
o 58: FAULT_FW_GENERIC_FAILURE 

o 61: FAULT_IOC_CONFIG_FAILURE 

o 68-71: FAULT_DYNx_SPS_FAILURE 
o 72-73: FAULT_AUXx_SPS_FAILURE 

o 74: FAULT_IOC_RELAY_STATUS 

o 75: FAULT_RLC_RELAY_STATUS 
o 76: FAULT_RLC_GLOBAL_STATUS 

o 85: FAULT_COMMS_CRC_FAILURE 

o 86: FAULT_COMMS_SEQ_FAILURE. 

• Improved tachometer/speed signal debounce filtering (FPGA) in order to help eliminate erroneous pulses on 
low-speed machines (typically hydro applications). 

Bug fixes: 

• High frequency tachometer signals took too much CPU load. 

• Condition monitoring (CM) sometimes failed to start, thereby preventing VibroSight from displaying data. 

• Issues obtaining status information from the module (affected by the pairing name for CM). 

• Maximum number of extractions per integration (none, once or twice) not verified by module. 

• MPC4Mk2 module rebooted constantly if IOC4Mk2 module not present. 

• MPC4Mk2 module UART (RX) generating unwanted system interrupts (due to noise). 
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• Sensor power supply (SPS) relay’s toggling when module resets (reboots) even if SPS not used (that is, 
configured as disabled). 

• Relays configured as latched were not latching when the input was configured as inverted (that is, relays 
configured with Invert input and Latched selected). 

• Logical function NOT gate could accept more than one logical input signal (logical operand). 

• Dynamic channel status bits (data quality flags) were incorrect for certain configurations. For example, missing 
TACHO OVERFLOW flag. 

Restrictions: 

• Only compatible with VibroSight 7.3. 

 

Condition monitoring firmware: 640-033-003-000 

Features: 

• Now uses SigProcLib version 209-216-208-000. 

Restrictions: 

• Only compatible with machinery protection firmware 640-025-008-000 and VibroSight 7.3. 

 

Recovery firmware: 640-031-006-000 

Bug fixes: 

• Condition monitoring (CM) sometimes failed to start, thereby preventing VibroSight from displaying data. 

Restrictions: 

• Only compatible with proof test firmware 640-032-004-000 and VibroSight 7.3. 

 

Proof test firmware: 640-032-004-000 

Features: 

• Now uses SigProcLib version 209-216-208-000. 

Restrictions: 

• Only compatible with recovery firmware 640-031-006-000 and VibroSight 7.3. 

 

See also 6.2 VM600Mk2/VM600 modules/cards. 
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2.24 MPC4Mk2 + IOC4Mk2 SIL module – firmware 

NOTE: SIL versions of firmware are for use with the MPC4Mk2 + IOC4Mk2 SIL module only 
(that is, PNR 601-040 for the MPC4Mk2 SIL). 

See also 2.1 Support for VM600Mk2 SIL – for critical safety-related applications. 

 

Initial release of VM600Mk2 MPC4Mk2 + IOC4Mk2 SIL machinery protection and condition monitoring module firmware 
with the following main improvements: 

 

SIL machinery protection firmware: 640-024-001T005 

Features: 

• Initial version of SIL-specific machinery protection firmware for use with the MPC4Mk2 + IOC4Mk2 SIL module. 

Restrictions: 

• Only compatible with VibroSight 7.3. 

 

Recovery firmware: 640-026-001-000 

Features: 

• Initial version of SIL-specific recovery firmware for use with the MPC4Mk2 + IOC4Mk2 SIL module. 

Restrictions: 

• Only compatible with VibroSight 7.3. 

 

NOTE: The current SIL versions of the VM600Mk2 modules are “beta” versions for test and 
evaluation only. 
It is important to be aware that the SIL certification process is ongoing and SIL 
certification is pending, so the MPC4Mk2 module cannot be Locked (that is, 
cannot be put into the safety/secure operating mode (of the Operational mode)). 
Accordingly, firmware upgrades to final versions of SIL-specific firmware will be 
required before a VM600Mk2 SIL system containing MPC4Mk2 + IOC4Mk2 SIL 
modules is used in critical safety-related applications. 
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2.25 CPUMMk2 + IOCNMk2 module – firmware 

Updated VM600Mk2 CPUMMk2 + IOCNMk2 rack controller and communications interface firmware with the following 
main improvements: 

 

Base-system / applications firmware: 640-034-003-001 

Bug fixes: 

• CPUMMk2 module crashed when uploading an invalid Modbus configuration (and would not accept another 
Modbus configuration). 

• CPUMMk2 module had problems with some type checks in Modbus configurations. 

• CPUMMk2 module indicated a configuration problem when an unconfigured XMC16 module was present in the 
same rack, even if the XMC16 module’s configuration was not controlled by the CPUMMk2 (for example, a 
XMC16 controlled directly by VibroSight). 

 

See also 6.2 VM600Mk2/VM600 modules/cards. 
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3 Important announcement concerning future versions of VibroSight 

3.1 VibroSight software and support for OPC HDA 

Please note that due to planned changes to the Microsoft .NET Framework – which are out of our control – it will 
soon no longer be possible for the VibroSight software to support OPC HDA (historical data access, part of 
OPC Classic). 

As a result of these changes and for commercial reasons, it has been decided to remove VibroSight’s support for 
OPC Classic servers (OPC DA (data access, “live” data) and OPC HDA) by the end of 2023. 

Please note that VibroSight will continue to support OPC Classic clients (allowing the import of data into a 
VibroSight database) and OPC UA, as before. 

Accordingly, it is recommended that customers who rely on VibroSight’s support for OPC Classic servers (OPC DA 
and OPC HDA) contact Alfonso Fernandez, Product Owner, VibroSight, in a timely manner to discuss alternative 
solutions. 
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4 Solved problems and bug fixes 

4.1 General improvements and bug fixes 

General stability improvements and bug fixes across the VibroSight 7.3.0 software. 

 

4.2 VibroSight Configurator not allowing VSV30x module frequency domain extractions to be 
configured with non-integer values 

In VibroSight Configurator, when configuring a VSV30x monitoring module to use Shaft relative vibration 
processing with frequency domain extractions, it was not possible to configure the Band stop parameter with a non-
integer value, as required for sub 1X measurements, such as 0.41 to 0.49 nX. 

For example, Band stop: 0.4 could not be used (but 1 could be used). 

 

4.3 VibroSight Protect not displaying VM600Mk2 MPC4Mk2 modules configured with manual IP 
address correctly 

In VibroSight System Manager, when a VM600Mk2 MPC4Mk2 machinery protection and condition monitoring module 
was configured with a Network settings Mode: Manual IP address (Configure tab/page, General tab) and a manual 
IP address, the module was not subsequently displayed correctly on the Dashboard tab/page. 

More specifically, after the configuration was activated on the modules, the module was displayed as being 
disabled. 

 

4.4 VibroSight Protect not allowing low-pass (LP) filter to be set to 120 dB/Octave 

In VibroSight Protect, when configuring a VM600Mk2 MPC4Mk2 module’s dynamic channel low-pass (LP) filter slope 
to 120 dB/Octave, the value was rejected and a maximum upper limit of 60 dB/Octave was reported. 

Note: The VM600Mk2 MPC4Mk2 module’s dynamic channel low-pass (LP) filter maximum slope was increased from 
60 dB/Octave to 120 dB/Octave in VibroSight 7.1, but there was an accidental regression back down to 
60 dB/Octave in in VibroSight 7.2. 

 

4.5 Custom dynamic processing function did not allow sensor signal sharing 

In VibroSight Protect, when configuring a Custom dynamic processing function for a dynamic measurement 
channel, it was not possible to configure sensor signal sharing using an existing signal input. 

 

4.6 VibroSight Capture displays incorrect waveform length 

In VibroSight Capture, when configuring the condition monitoring processing for Shaft relative vibration, 
Bearing absolute vibration and Custom dynamic processing functions, the calculated waveform length (in seconds) 
displayed by VibroSight Capture was incorrect. 
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4.7 VibroSight Capture not displaying sensors when a Rotor expansion (dual taper) is 
connected to a dual taper shaft 

In VibroSight Capture, on the Connect tab/page, when a Rotor expansion (dual taper) processing function is 
connected to a dual taper shaft machinery component of a machine train, the sensors are not displayed on the 
machinery component / machine train. 

 

4.8 VibroSight Capture not displaying sensors correctly when a Rotor expansion (pendulum) is 
connected to a dual taper shaft 

In VibroSight Capture, on the Connect tab/page, when a Rotor expansion (pendulum) processing function is 
connected to a machinery component of a machine train, the sensors are not displayed correctly on the machinery 
component / machine train. 

 

4.9 VibroSight Capture Connect tab/page not displaying all sensor information 

On the VibroSight Capture Connect tab/page, used to establish the connections (links) between the machine train 
components and the measurements, it was not possible scroll down the machine train image (top) in order to see 
all of the sensors attached to a particular machine train component. For example, all of the air-gap sensors 
attached to a large generator for a hydro machine. 

 

4.10 VibroSight Mimic performance-related issues 

In VibroSight Mimic, for large Mimic projects consisting of a sizeable number of Mimic pages, there were a number 
of performance-related issues, typically characterised by slow Mimic loading/start-up times, significant image 
flickering when switching between Mimic pages and/or Mimic stopping working (crashing). 

 

4.11 VibroSight System Manager not allowing the download of a GSD file from VM600Mk2 
CPUMMk2 modules 

In VibroSight System Manager, it was not possible to download a GSD file directly from a VM600Mk2 CPUMMk2 rack 
controller and communications interface module using the Download GSD file command (in the Actions view, right), 
as the command was not displayed. 

NOTE: A general station description (GSD) file is a device description file provided with 
PROFIBUS and PROFINET devices. With a GSD file, system integrators can 
determine basic data such as the communications options and available 
diagnostics, and the supervision software (PROFIBUS or PROFINET “master” 
device) can plan the configuration of the system. 
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4.12 VibroSight Server Math processing block scalar data entity expression evaluation 
returning incorrect results 

In VibroSight Configurator, when configuring a VibroSight Server with a Math processing block and scalar data 
entities, when the Expression and Test boxes are used to develop and evaluate an expression, if the expression is 
followed by more than one <ENTER> character, then the value returned is 0 (zero). 

For example: 

Expression: 3 * 4 <ENTER> results in Test / Result: 12, which is correct. 

Expression: 3 * 4 <ENTER> <ENTER> results in Test / Result: 0, which is incorrect. 

 

4.13 VM600Mk2 MPC4Mk2 module pre-logging not working 

For the VM600Mk2 MPC4Mk2 machinery protection and condition monitoring module, pre-logging based on an alarm 
event was not working: no pre-logging data was available and a message was displayed by VibroSight Server: 
“ … The pre logging request cannot be executed at this time”. 

Note: Post-processing was still working. 
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5 Known issues 

5.1 Security risks 

A number of Open web application security project (OWASP) security risks have been identified related to a 
UPC UA library used by the VibroSight software. This UPC UA library is from a third-party (Softing AG, Softing 
Industrial Automation GmbH), who have recently implemented a fix. However the improved UPC UA library is not 
included in the latest release of VibroSight. 

For information, the specific issues that have been identified are: 

• CVE-2022-29862: An infinite loop in OPC UA .NET Standard Stack 1.04.368 allows a remote attackers to 
cause the application to hang via a crafted message 

• CVE-2022-29863: OPC UA .NET Standard Stack 1.04.368 allows remote attacker to cause a crash via a 
crafted message that triggers excessive memory allocation. 

• CVE-2022-29864: OPC UA .NET Standard Stack 1.04.368 allows a remote attacker to cause a server to crash 
via a large number of messages that trigger Uncontrolled Resource Consumption. 

• CVE-2022-29865 : OPC UA .NET Standard Stack 1.04.368 allows a remote attacker to bypass the application 
authentication check via crafted fake credentials 

• CVE-2022-29866: OPC UA .NET Standard Stack 1.04.368 allows a remote attacker to exhaust the memory 
resources of a server via a crafted request that triggers Uncontrolled Resource Consumption. 

 

5.2 Display of timestamps in VibroSight Vision 

In VibroSight Vision, when the timestamps (date and time) are configured to be displayed as Site time or Local 
computer time and the site time or local computer time is subsequently changed on the relevant computer (for 
example, using Windows > Control Panel > Date and Time), this change is not reflected in the VibroSight Vision 
user interface until the user clicks on the Timestamp displayed in the VibroSight Vision status bar. 

 

5.3 VibroSight Server and Host Service restart required after changes to network adapter 

If the configuration of a network adapter is changed (for example, enabled or disabled, connected or disconnected) 
on a computer running VibroSight, then the VibroSight Servers and Host Services running on the computer must 
be restarted in order for the network adapter to be recognized by the VibroSight discovery mechanism. 

 

5.4 Length limitation of VibroSight Server instance names 

Since VibroSight 2.9.6, VibroSight Server instance names are limited to 18 characters, whereas up to 
27 characters were allowed in previous versions. This constraint is enforced during the creation of new server 
instances with VibroSight 2.9.6 or later. 
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NOTE: VibroSight allows only alphanumeric characters (A to Z, a to z, 0 to 9), the 
hyphen-minus character ( - ) and the underscore character ( _ ) to be used for 
VibroSight Server names. 

However, existing server instances may be non-compliant (too long) and no longer run after an upgrade of the 
VibroSight software. In such cases, the file names used for a VibroSight Server database file (*.vssrvdb or *.db) 
and a VibroSight Server configuration file (*.vssrvcfg or *.config) should be updated (and manually edited in the 
VibroSight configuration file) to be 18 characters or less. Changes may also be required in any VibroSight software 
that references the server instance name, such as VibroSight Vision projects. 

Where used, the automated data management commands and operations that append a timestamp 
(_yyyyMMddHHmmss) to the Server instance name reduces the number of file name characters that remain 
available for VibroSight Server instance names to three. Alternatively, the server instance name can be shorted 
after the data repository command or operation is complete. 

Also, depending on the VibroSight Server data repository (database) file names used and any truncation performed 
by VibroSight, it is possible that servers are created with names that contain non-allowed characters (such as 
spaces), with the result that these servers will not be accessible by VibroSight software clients. Similarly, duplicate 
VibroSight Server names are also possible. 

NOTE: Choose appropriate VibroSight Server names in order to avoid name conflicts 
arising due to truncation and/or additional data repositories being created during 
automatic data management. 

This is particularly important for systems with automated data management and 
system backup procedures that can generate VibroSight Server data repositories 
with different file names. 

 

5.5 Display of timestamps in VibroSight clients other than VibroSight Vision 

Although VibroSight Vision now supports the display of timestamps (date and time) as either Site time, UTC time or 
Local computer time, all other VibroSight client software modules continue to display timestamps in local computer 
time only (that is, the date and time according to the local clock of the computer running the VibroSight software 
module). 

 

5.6 Display of devices in VibroSight System Manager 

In the System Explorer window of VibroSight System Manager, the Devices tree-view does not always update 
correctly to show all of the devices (VM600 modules/cards and VibroSmart devices) available on the network. 

In particular, this has been seen when changing the firmware of a device, and can persist even after a refresh 
(using the Refresh toolbar button or View > Refresh). 

If this behaviour is seen, the recommended workaround is to: 

• Wait a few minutes and refresh again. 

• Restart VibroSight System Manager. 
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5.7 VibroSight Mimic backwards compatibility 

VibroSight 2.10.0 contained significant improvements and changes, including a separate VibroSight Mimic client 
software module for mimics (that were previously available in VibroSight Vision). As a result, VibroSight Vision 
mimics created with VibroSight 2.9.7 or earlier are not compatible with VibroSight 2.10.0 or later. 

VibroSight 2.11.0 contained significant improvements and changes to the VibroSight Mimic client software module. 
As a result, VibroSight Vision mimics created with VibroSight 2.10.1 or earlier are not compatible with VibroSight 
2.11.0 or later. 

VibroSight 2.11.5 contained significant improvements to the VibroSight Mimic project framework to include version 
information, in order to improve the compatibility between projects created with different versions of VibroSight 
Mimic and eliminate the requirement for the recreation of Mimics. Starting with VibroSight 2.11.5, Mimic projects 
automatically detect any changes in the VibroSight Mimic software that affect project compatibility, inform the user 
and update the project as required. 

 

NOTE: VibroSight 2.11.5 is also able to open and work with Mimic projects created with 
VibroSight 2.11.0 or later, if the corresponding database had been updated as 
required. 

 

NOTE: When updating existing machinery monitoring projects created with 
VibroSight 2.12.x to VibroSight 3.x.x or later, a new data repository created by 
copying a VibroSight database (*.vssrvdb) to a VibroSight historical data folder 
(*.vshdf) must use the same server file name as the existing server in order for 
existing VibroSight Mimics to maintain links with the data repository and continue to 
work (without manual corrections). 
In addition, the VibroSight Server using the new data repository must be running 
before the existing VibroSight Mimics are run for the first time, after the update. 

 

5.8 VibroSight OPC Clients not recovering 

When a VibroSight OPC Client is being used to import information from an external OPC server into a VibroSight 
system and the external OPC server becomes unavailable, the VibroSight OPC Client may not always recover 
automatically when the OPC server becomes available again. 

This is typically characterised by the VibroSight OPC Client continuing to show connection error messages even 
when OPC server is available and can result in permanent loss of the imported data if not noticed. 

NOTE: The external OPC data can be permanently lost if it is not imported into VibroSight 
as expected. 

Any VibroSight system feature or configuration element relying on the imported 
OPC data will not behave as expected, for example, alarms, machinery operating 
conditions and data logging rules. 
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If this behaviour is seen, the recommended workaround is to: 

• Stop and restart the VibroSight OPC Client from either the VibroSight Server 
(Data > Acquisition > OPC Device Driver) or VibroSight System Manager. 

• Stop and restart the VibroSight Server, if required. 

 

5.9 Duplicate events 

For VibroSight systems using VM600 XMx16 cards, VibroSight Event Viewer retrieves all of the event information 
available from the data buffers on the cards. 

For VibroSight systems using VibroSmart modules, VibroSight Event Viewer retrieves the event information 
available from the current time only (no buffered events). 

Accordingly, for a VibroSight system using VM600 XMx16 cards, there is the possibility of duplicate events being 
listed in the Event Viewer, particularly for VibroSight systems being operated without an NTP server (where events 
are not recognised as duplicates due to time drift). 

 

5.10 VibroSight Server status indicators 

The status indicators (performance counter monitors) on the Status tab of the new VibroSight Server are not 
correctly displayed and updated when an NVIDIA WMI driver is installed on the same computer as the VibroSight 
Server. 

NOTE: The NVIDIA Enterprise Management Toolkit (NVWMI) is a graphics and display 
management and control technology that interfaces to Microsoft’s Windows 
Management Instrumentation (WMI) infrastructure, specific to NVIDIA graphics 
processing units (GPUs). 

 

This is because NVIDIA WMI prevents the Microsoft .NET Framework from obtaining the required counter values 
from the underlying operating system / computer. 

 

5.11  XMx16 card pre-logging 

For an XMx16 card pair, if Dynamic Input Channel 16 is used as an input to a Dynamic Processing Block that is 
used as an input to a Dual Shaft Relative Processing Block which is configured to provide an Orbit and/or Full 
Spectrum output, then any pre-logging configured for the principal mode Waveform and/or Spectrum of Dynamic 
Input Channel 16 will not actually log any of the data from the same pre-logging scope. 

 

5.12  Problems creating new VibroSight OPC Classic Servers 

Users who have upgraded from an earlier version of VibroSight to a later version (for example, from 
VibroSight 2.x.x or 3.0.0 to VibroSight 3.1.0) can experience problems when creating new VibroSight OPC Classic 
Servers. 
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Such problems are typically characterised by the OPC Server Create command in VibroSight System Manager 
displaying an error message such as 
“The type initializer for ‘ch.VibroMeter.Xms.OpcServer.Utils.OpcServerUtils’ threw an exception”. 

This typically occurs because an earlier version of the OpcServer.config file required by VibroSight OPC Classic 
Servers is being used by the later installation of VibroSight, which can happen in one of two ways: 

• When a version of VibroSight 3.x.x or later is installed on a computer that was running a version of 
VibroSight 2.x.x or earlier, the VibroSight installer automatically checks existing VibroSight folders (such as 
C:\ProgramData\Meggitt\VibroSight 2) in order to copy relevant system and/or user preference files across to 
the new VibroSight folders (such as C:\ProgramData\Meggitt\VibroSight), including an earlier 
OpcServer.config file. 

• When VibroSight 3.1.0 is installed on a computer that was running VibroSight 3.0.0, the creation of a 
VibroSight OPC Classic installer using VibroSight 3.0.0 automatically created an earlier OpcServer.config file. 

As shown below, the first few lines of a typical OpcServer.config file contains version specific information that is 
incompatible with later versions of VibroSight: 

<?xml version="1.0" encoding="utf-8"?> 

<configuration> 

  <configSections> 

    <section name="opcServersConfiguration" type="ch.VibroMeter.Xms.OpcServer.Utils.OpcServersSystemConfiguration, 
XmsOpcServerUtils, Version=2.0.0.0, Culture=neutral, PublicKeyToken=2db2a2387bac0a0a" /> 

  </configSections> 

… 

</configuration> 

 

So for users who have upgraded from an earlier version of VibroSight to a later version, if problems are 
experienced when creating new VibroSight OPC Classic Servers, the workaround is to: 

 

1. Use an XML-compatible text editor program to edit the OpcServer.config file and remove the version specific 
information. That is, change the line containing the section name 
from: 

<section name="opcServersConfiguration" type="ch.VibroMeter.Xms.OpcServer.Utils.OpcServersSystemConfiguration, 
XmsOpcServerUtils, Version=2.0.0.0, Culture=neutral, PublicKeyToken=2db2a2387bac0a0a" /> 

to: 

<section name="opcServersConfiguration" type="ch.VibroMeter.Xms.OpcServer.Utils.OpcServersSystemConfiguration, 
XmsOpcServerUtils, Culture=neutral, PublicKeyToken=2db2a2387bac0a0a" /> 

 

2. Restart the computer. 
    Note: The computer must be restarted to ensure that the edited version of the OpcServer.config 
    file is used (and not some other version from cache memory). 
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3. Use the OPC Server Create command in VibroSight System as required. 

 

NOTE: The manual migration of existing VibroSight OPC Classic Servers to 
VibroSight 3.x.x or later is described in detail in the “VibroSight OPC Classic Server 

migration” section of the latest  Getting started with VibroSight installation 
guide. 

 

5.13  Potential TCP port 50000 conflict 

The VibroSight Host Service (XmsHostService.exe) requires TCP port 50000 for communication with the 
VibroSight software. So if the computer running the VibroSight software is running other software which also 
requires TCP port 50000, this results in a TCP port conflict which can prevent VibroSight (or the other software) 
from running. 

During the VibroSight software installation process, the VibroSight 3.4.x or later installer will typically detect other 
software on the computer that is using TCP port 50000 and report this. For example: “The port 50000 cannot be 
used. Please close all application using this port before manually starting the host service.” 

Accordingly, any potential TCP port 50000 conflicts should be resolved before the VibroSight software can be 
successfully run. 

NOTE: The VibroSight software’s TCP and UDP port requirements are described in detail 

in the “Software installation” section of the latest  Getting started with 
VibroSight installation guide. See section 4. After installing VibroSight. 

 

5.14  Problems using shared network drives/locations for VibroSight data management 

On computers running Windows 10 or Windows Server 2016, problems can be experienced using shared network 
drives/locations with VibroSight’s integrated data management operations such as Offline data storage and 
Database backup (configured in VibroSight Configurator) due to Windows security policies and restrictions. 

Such problems are typically characterised by the individual copy commands scheduled and run on a VibroSight 
Server (corresponding to Offline data storage and Database backup operations) failing to run correctly. More 
specifically, on the Data Management tab of a VibroSight Server, scheduled incremental copy jobs (Type: Copy) 
are typically displayed with Status: Error, while the Log Messages tab of the server display typically displays 
messages such as “Errors during the copy operation” and “Uncaught error IOException occurred in task ‘Task 
“DataRepositoryCopyDataMan…”. 

NOTE: For Windows 10 and Windows Server 2016, Microsoft improved network security 
with a change to the rules governing shared network drives/locations. 
More specifically, a shared network drive/location is now only accessible and 
visible to the user who created the shared network drive/location, even if the user is 
an Administrator. 
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Accordingly, in order to avoid such problems, a shared network drive/location on Windows 10 and 
Windows Server 2016 computers that is required to be used by VibroSight’s integrated data management 
operations should be created as a “system account” in order to ensure that the required Windows Services can 
access the shared resource (drive/location). 

This can easily be done using Microsoft’s PsExec utility. For example, by running the following command (as an 
Administrator): 

PsExec.exe -i -s cmd.exe /C "net use Z: \\server\share"  

Where the net use command is used to map the \\computer name\sharename (\\server\share) to the devicename 
(Z:). 
 

NOTE: For Windows 10 and Windows Server 2016, Microsoft improved network security 
with a change to the rules governing shared network drives/locations. 
More specifically, a shared network drive/location is now only accessible and 
visible to the user who created the shared network drive/location, even if the user is 
an Administrator. 

 

5.15  Problems installing VibroSight 3.7.x on computers without internet access 

On computers which are not connected to the internet, the VibroSight 3.7.x installer can experience problems when 
automatically installing the prerequisite Microsoft Visual C++ Redistributable Package for Visual Studio 2015, and 
report a generic message such as “Setup Failed. One or more issues caused the setup to fail”. 

As a workaround, trying to manual install the Microsoft Visual C++ Redistributable Package for Visual Studio 2015, 
the Microsoft Visual C++ installer can also experience problems, and report a similar generic “Setup Failed” 
message. 

This is a known Microsoft problem which is due to some components in Visual Studio being signed by a 
certification authority that is not installed on the computer, and the computer cannot automatically download the 
required certificate(s) because it is not connected to the internet. 

Accordingly, the Microsoft solution is to: 

1. On a computer which is connected to the internet, download the following certificate: 
http://www.microsoft.com/pki/certs/MicRooCerAut2011_2011_03_22.crt  
Then copy the certificate to the VibroSight computer (for example to C:\Temp). 

2. On the VibroSight computer, use the certmgr.exe utility to add the certificate by using the command line. 
Note: For more information, refer to the Certmgr.exe (Certificate Manager Tool) topic at MSDN. 

3. Open an admin command prompt and run the following command: 
certmgr.exe /add C:\Temp\MicRooCerAut2011_2011_03_22.cer /s /r localMachine root 

4.  Next, try installing the patch KB3135996 or KB3136000. 
 
If required, additional information is available from a Microsoft MSDN blog, here: 
https://blogs.msdn.microsoft.com/vsnetsetup/2016/03/28/a-certificate-chain-could-not-be-built-to-a-trusted-root-
authority-2 

https://docs.microsoft.com/en-us/sysinternals/downloads/psexec
https://blogs.msdn.microsoft.com/vsnetsetup/2016/03/28/a-certificate-chain-could-not-be-built-to-a-trusted-root-authority-2
https://blogs.msdn.microsoft.com/vsnetsetup/2016/03/28/a-certificate-chain-could-not-be-built-to-a-trusted-root-authority-2
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6 Compatibility 

As part of the VibroSight software installation process, the VibroSight installer will automatically check to see if the 
required Microsoft .NET Framework, Microsoft Visual C++ Redistributable Package, OPC Core Components 
Redistributable software and OPC UA Local Discovery Server are pre-installed on the computer: 

• The required Microsoft Visual C++ Redistributable Package (see section 6.1.3) must be manually installed 
before VibroSight can be installed. If it is not detected, then the VibroSight installer will exit the installation and 
VibroSight is not installed. 

• The required Microsoft .NET Framework (see section 6.1.2) is automatically installed by the VibroSight installer 
if it is not detected. 

• The required OPC Core Components Redistributable (see section 6.1.4) software is automatically installed on 
the computer by the VibroSight installer if it is not detected. 

• The required OPC UA Local Discovery Server (see section 6.1.5) software is automatically installed on the 
computer by the VibroSight installer if it is not detected. 

NOTE: Refer to the latest version of the  Getting started with VibroSight installation 

guide or the  VibroSight software data sheet for further information on 
VibroSight’s prerequisites and compatibility. 

 

 

6.1 VibroSight software 

VibroSight 7.3.0 is a minor level release and replaces VibroSight 7.2.x. 

Compatibility with existing VibroSight data repositories (databases) is achieved using a specific data migration 
process from any existing databases based on Sybase SQL Anywhere (*.vssrvdb) to data repositories based on 
the VibroSight historical data repositories (VibroSight historical data folder (*.vshdf) for operation with a VibroSight 
Server (live data) and VibroSight historical data archive (*.vshda) for operation with historical data). 

Compatibility with existing VibroSight machinery monitoring projects using VibroSight OPC Servers that were 
created using VibroSight 2.12.7 or earlier is achieved using a specific VibroSight OPC Server migration process for 
these VibroSight OPC Servers. 

Therefore, it is important to note that: 

• New machinery monitoring projects created with VibroSight 7.x.x (VibroSight 3.x.x or later) will automatically 
use VibroSight historical data repositories. 

• Existing machinery monitoring projects created with versions of VibroSight earlier than VibroSight 3.0.0 must 
be manually migrated from Sybase SQL Anywhere databases to VibroSight historical data repositories before 
they can be used with VibroSight 7.x.x (VibroSight 3.x.x or later). 

• Existing machinery monitoring projects using VibroSight OPC Servers that were created with versions of 
VibroSight earlier than VibroSight 2.12.7 must manually migrate their VibroSight OPC Servers before they can 
be used with VibroSight 7.x.x (VibroSight 3.x.x or later). 
It is very important to note that migrating a VibroSight OPC Server from VibroSight 2.12.7 or earlier to 
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VibroSight 7.x.x (VibroSight 3.x.x or later) or later requires that certain steps must be performed using the 
existing version of VibroSight (that is, VibroSight 2.12.7 or earlier) BEFORE it is removed (uninstalled). 

NOTE: The manual migration of an existing machinery monitoring project to 
VibroSight 7.x.x (VibroSight 3.x.x or later) or later is described in detail in the 
“Data migration” and “VibroSight OPC Server migration” sections of the latest  

 Getting started with VibroSight installation guide. 

 
 
6.1.1 Microsoft Windows operating systems 
VibroSight 7.x.x (VibroSight 3.x.x or later) or later is compatible with 32-bit versions and 64-bit versions of 
Microsoft ® Windows ® operating systems. 

NOTE: Starting with VibroSight 3.0.0, VibroSight software is now available as 64-bit 
software for 64-bit Windows and 32-bit software for 32-bit Windows. 
The 64-bit version of VibroSight can be installed on 64-bit Windows computers 
only. The 32-bit version of VibroSight can be installed on 32-bit Windows 
computers only. Only a single version of VibroSight can be installed and exist on a 
computer at any one time 

 
See the Appendix of these release notes for further information on VibroSight software and Windows operating 
system compatibility. 

 

 

6.1.2 Microsoft .NET Framework 
For most Windows operating systems, VibroSight 7.x.x (VibroSight 3.7.0 or later) requires that the Microsoft .NET 
Framework 4.7.2 or later is installed. 

NOTE: VibroSight 7.x.x requires Microsoft .NET Framework 4.7.2. 

 
If the required Microsoft .NET Framework is not pre-installed, then the VibroSight installer will detect this and 
automatically install it as part of the VibroSight software installation process. 

See the Appendix of these release notes for further information on VibroSight software and Microsoft .NET 
Framework requirements. 
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6.1.3 Microsoft Visual C++ Redistributable Package 
VibroSight 7.x.x (VibroSight 3.x.x or later) requires that the Microsoft Visual C++ Redistributable Package for Visual 
Studio 2015 is installed, in order to install and register the Visual C++ libraries used by VibroSight. 

NOTE: The 64-bit version of the Microsoft Visual C++ Redistributable Package (“Microsoft 
Visual C++ 2015 Redistributable (x64)”) must be installed on 64-bit Windows 
computers. 
The 32-bit version of the Microsoft Visual C++ Redistributable Package (“Microsoft 
Visual C++ 2015 Redistributable (x86)”) must be installed on 32-bit Windows 
computers. 

If the required Microsoft Visual C++ Redistributable Package is not pre-installed, then the VibroSight installer will 
detect this and exit the installation. 

 

 

6.1.4 OPC Core Components Redistributable 

VibroSight 7.x.x (VibroSight 3.x.x or later) requires that the OPC Core Components Redistributable is installed, in 
order to configure and run VibroSight OPC Clients and VibroSight OPC Servers correctly: the redistributable must 
be installed on OPC client computers in order to allow connections to remote OPC servers and it must be installed 
on OPC server computers in order to allow OPC clients to browse for running OPC servers. 

NOTE: The 64-bit version of the OPC Core Components Redistributable (“OPC Core 
Components Redistributable (x64) 106.0”) must be installed on 64-bit Windows 
computers. 

The 32-bit version of the OPC Core Components Redistributable (“OPC Core 
Components Redistributable (x86) 106.0”) must be installed on 32-bit Windows 
computers. 

 

If the required OPC Core Components Redistributable is not pre-installed, then the VibroSight installer will detect 
this and automatically install it as part of the VibroSight software installation. 

 

 

6.1.5 OPC UA Local Discovery Server  

VibroSight 7.x.x or later requires that the OPC UA Local Discovery Server is installed, in order to expose OPC UA 
servers for discovery and enable communications with OPC UA clients. 

If the required OPC UA Local Discovery Server is not pre-installed, then the VibroSight installer will detect this and 
automatically install it as part of the VibroSight software installation. 
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6.1.6 Sybase SQL Anywhere 11 software 

VibroSight 7.x.x (VibroSight 3.x.x or later) does not include any Sybase SQL database software. 

Starting with VibroSight 3.0.0, the VibroSight historical data repositories (VibroSight historical data folder (*.vshdf) 
for operation with a VibroSight Server (live data) and VibroSight historical data archive (*.vshda) for operation with 
historical data) are exclusively used for the required data repositories. 

A VibroSight database based on Sybase SQL Anywhere (*.vssrvdb) can no longer be used as a data repository. 
Accordingly, the Sybase SQL Anywhere 11 database software is no longer included and distributed as part of the 
VibroSight software. 

NOTE: VibroSight 3.x.x or later exclusively uses data repositories based on the VibroSight 
historical data system. 

VibroSight 2.12.7 used data repositories based on Sybase SQL Anywhere 
databases and introduced initial support for working with data repositories based 
on the VibroSight historical data repositories for data analysis. 

VibroSight 2.12.6 or earlier exclusively used data repositories based on Sybase 
SQL Anywhere databases. 

 

NOTE: The manual migration of an existing machinery monitoring project to 
VibroSight 7.x.x (VibroSight 3.x.x or later) is described in detail in the 

“Data migration” section of the latest  Getting started with VibroSight 
installation guide. 

 

 

6.1.7 Dell Backup and Recovery software 

Some Dell™ computers running versions of Dell Backup and Recovery software can experience problems running 
the VibroSight software, characterised by the VibroSight software not running or running incorrectly. This is 
because the Dell Backup and Recovery software can use a version of SQLite and associated libraries (DLLs) that 
prevent the VibroSight Host Service from running correctly. 

For example, VibroSight clients can stop running (crash), VibroSight clients can be unable to connect to data 
sources and/or VibroSight System manager may not display all of the commands expected to be available in the 
Actions window. 

If this behaviour is seen, the recommended workaround is to uninstall the Dell Backup and Recovery software. 

NOTE: It is recommended to install and use VibroSight 3.x.x or earlier on a computer that 
does not have Dell Backup and Recovery software installed. 
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6.1.8 MatrikonOPC software 

Both MatrikonOPC™ software and the VibroSight software can be installed and run on the same computer. 

However, if the MatrikonOPC software is installed after the VibroSight software, this can result in problems related 
to credentials (access rights). These problems are typically characterised by an unhandled exception in VibroSight 
Configurator when trying to configure an OPC device in the Hardware view or an unhandled exception in a 
VibroSight Server when trying to handle/process OPC data. 

MatrikonOPC software and the VibroSight software must be installed on the same computer in the following order: 

1. Install the MatrikonOPC software. 

2. Install the Microsoft Visual C++ Redistributable Package for Visual Studio 2010 (version 40219). 
Note: This redistributable package is required by the MatrikonOPC software. 

3. Install the Microsoft Visual C++ Redistributable Package for Visual Studio 2015 (version 23026 or later). 
Note: This redistributable package is required by the VibroSight software. 

4. Install VibroSight 3.x.x or later. 
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6.2 VM600Mk2/VM600 modules/cards 

6.2.1 Module/card firmware 

There are some firmware upgrades for VM600Mk2/VM600 modules/cards corresponding to VibroSight 7.3.0. 

 

The latest firmware for the VM600Mk2 MPC4Mk2 module is: 

• Machinery protection: 640-025-008-000.Mpc4g2Fw (updated) 

• Condition monitoring: 640-033-004-000.VxeFw (updated) 

• Recovery: 640-031-006-000.Mpc4g2Fw (updated) 

• Proof test: 640-032-004-000.VxeFw (updated). 

See 2.22 MPC4Mk2 + IOC4Mk2 module – hardware and 2.23 MPC4Mk2 + IOC4Mk2 module – firmware. 

 

The new initial firmware for the VM600Mk2 MPC4Mk2 SIL module is: 

• Machinery protection: 640-024-001T005.SafeMpc4g2Fw (new) 

• Condition monitoring: 640-033-004-000.VxeFw (updated) 

• Recovery: 640-026-001-000.SafeMpc4g2Fw (new) 

• Proof test: 640-032-004-000.VxeFw (updated). 

See 2.22 MPC4Mk2 + IOC4Mk2 module – hardware and 2.24 MPC4Mk2 + IOC4Mk2 SIL module – firmware. 

 

The latest firmware for the VM600Mk2 CPUMMk2 module is: 

• Base system: base-system-640-034-003-001.tgz (updated). 

See 2.25 CPUMMk2 + IOCNMk2 . 

 

The latest firmware for the VM600 CPUR2 card remains: 

• Applications: applications-640-015-001-006.tgz 

• Base System : base-system-640-014-001-006.tgz. 

 

The latest firmware for the VM600 CPUR card remains: 

• Applications: applications-640-012-001-005.tgz 

• Base System: base-system-640-011-001-005.tgz. 
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The latest firmware for the VM600Mk2/VM600 XMC16, XMV16 and XMVS16 cards remains: 

• Applications: applications-640-010-001-016.tgz 

• Base System: base-system-640-003-001-016.tgz. 

 

Therefore, for current versions of VibroSight and VM600Mk2/VM600 systems, firmware upgrades are required. 

 

 

6.3 VibroSmart devices 

6.3.1 Module firmware 

There are no firmware upgrades for VibroSmart modules and devices corresponding to VibroSight 7.3.0. 

 

The latest firmware for the VSI010 module remains: 

• 642-002-000-014.xmsifw  

 

The latest firmware for the VSN010 device remains: 

• 642-004-000-012.redboxfw  

 

The latest firmware for the VSV30x module remains: 

• 642-001-000-020.xtranfw  

 

Therefore, for current versions of VibroSmart modules and devices, no firmware upgrades are required. 
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7 Upgrade procedure 

This section describes the procedure for upgrading a VibroSight system from a previous version. Perform the steps 
in the given sequence in order to complete a system upgrade. 

NOTE: Before starting a VibroSight system update, it is strongly recommended to verify 
the version of firmware(s) running on the related hardware (VM600Mk2/VM600 
and/or VibroSmart modules/devices) in order to establish if any firmware 
changes/upgrades are also required. 
See 7.2.3 Updating the firmware using VibroSight System Manager. 

 

IMPORTANT 
NOTE: 

Before upgrading the firmware of any of the hardware (VM600Mk2/VM600 and/or 
VibroSmart modules/devices) used in a VibroSight system, it is strongly 
recommended to ensure that a copy of the configuration for the system is available 
– in case it is necessary to reconfigure the system after the upgrade. 
See 7.2.3 Updating the firmware using VibroSight System Manager. 

 

 

7.1 VibroSight software user settings 

The VibroSight Software generates and uses some files on the storage device of the computer running VibroSight 
to keep track of user-configurable settings, so that these settings are remembered and applied for the VibroSight 
installation. 

These settings files have an .xmssettings file name extension and on a computer running Windows 7, can be found 
here: 

C:\Users\username\AppData\Roaming\Meggitt\VibroSight, where username is the Windows account name. 

For example, the VibroSightVision.xmssettings file records the user-configurable default settings for VibroSight 
Vision, such as default settings for plots. 

NOTE: VibroSight software updates and upgrades do not replace these settings files, so: 
• For a computer on which VibroSight was previously installed, an update, upgrade 
or a re-installation of VibroSight will continue to use the previous defaults recorded 
in the .xmssettings files. 
• For a computer on which VibroSight was not previously installed, the installation 
of VibroSight will generate and use new .xmssettings files, which use the latest 
VibroSight software defaults. 

If a settings file is deleted for any reason, VibroSight will generate and use a new 
settings file, which uses the latest VibroSight software defaults. 
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7.2 Updating VibroSight-compatible hardware 

Appropriate files and tools are included in the installation package to allow VM600Mk2/VM600 and/or VibroSmart 
modules/devices to be upgraded to the latest firmware, in order to take advantage of improvements to the 
VibroSight software. 

NOTE: Updating the firmware for VM600Mk2/VM600 and/or VibroSmart modules/devices is 
a special task that can, if used unintentionally or incorrectly, lead to malfunctioning 
of the device and affect proper function of data acquisition. It is therefore strongly 
recommended to change the firmware of VibroSight-compatible hardware only 
when it is necessary. For example, when the devices must be updated to be 
compatible with a VibroSight software upgrade. 

During the firmware update of a device, the card or module being updated cannot 
provide its normal machinery monitoring functions because its outputs (alarms and 
relays) can go to undetermined states, irrespective of how they have been 
configured. 

 

IMPORTANT 
NOTE: 

It is highly recommended that firmware updates are only performed in accordance 
with the operating procedures for the machinery being monitored and that 
appropriate precautions are taken at the control system level (such as DCS 
or PLC). 

For example, alarms and relay outputs should be ignored (bypassed or inhibited) in 
order to avoid false trips of the machinery being monitored. 

 

For example, for VibroSmart modules, the machinery being monitored is not protected for the duration of a 
firmware update and the restart (reboot) that is triggered automatically after the firmware update (which can take up 
to 5 minutes). 
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7.2.1 VM600Mk2/VM600 module/card firmware 

The latest VM600Mk2/VM600 module/card firmware files are copied to a directory on your computer as part of the 
VibroSight software installation process. 

NOTE: For example, the default firmware directory for VM600Mk2/VM600 modules/cards is: 
C:\Program Files\Meggitt\VibroSight\Firmware\VM600 

 

The firmware files for a VM600Mk2/VM600 module/card can be found in the appropriate subfolder and identified by 
their .tgz file name extension. 

For example, the MPC4 Mk2 subfolder contains the firmware components for use by the MPC4Mk2 module 
(standard versions) and the MPC4 Mk2 SIL subfolder contains the firmware components for use by the 
MPC4Mk2 SIL module (SIL versions). Any additional firmware updates received from Meggitt SA should also be 
stored in these directories. 

Table 1 shows the compatibility between VibroSight software and VM600Mk2 MPC4Mk2 module hardware (that is, 
MPC4Mk2 firmware) for later versions of the MPC4Mk2 (PNRs 600-041-001-002 and 600-041-000-002). 

Table 2 shows the compatibility between VibroSight software and VM600Mk2 MPC4Mk2 module hardware (that is, 
MPC4Mk2 firmware) for the original version of the MPC4Mk2 (PNR 600-041-000-001) – no longer supported. 
See 2.22 MPC4Mk2 + IOC4Mk2 module – hardware. 

Table 3 shows the compatibility between VibroSight software and VM600Mk2 MPC4Mk2 SIL module hardware (that 
is, MPC4Mk2 SIL firmware). 

IMPORTANT 
NOTE: 

When changing (upgrading) all firmware components on a VM600Mk2 MPC4Mk2 
module, the module must be in the Recovery mode in order to change the 
proof test firmware. 

It is important to note that entering the Recovery mode clears the modules 
configuration, which means that the module (system) must be reconfigured after 
leaving the Recovery mode – before normal system operation can be resumed. 

Accordingly, it is strongly recommended to ensure that a copy of the configuration 
for the system is available before upgrading a system. For example, the VibroSight 
software can be used to connect to a system (which will automatically 
read/download the system configuration) and save a copy of the configuration. 

 

 

Table 4 shows the compatibility between VibroSight software and VM600Mk2 CPUMMk2 module hardware (that is, 
CPUMMk2 firmware). 

Table 5 shows the compatibility between VibroSight software and VM600 CPUR2 card hardware (that is, 
CPUR2 firmware). 

Table 6 shows the compatibility between VibroSight software and VM600 CPUR card hardware (that is, 
CPUR firmware). 
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Table 7 shows the compatibility between VibroSight software and VM600 XMx16 card hardware (that is, 
XMC16, XMV16 and XMVS16 firmware). 

NOTE: It is strongly recommended to use the most recent version of the VM600 CPUR 
firmware and VM600 XMx16 firmware that is compatible with the version of 
VibroSight software being used. 

 

 

 

  



 

Document reference VIBROSIGHT-RN/E (660-010-013-236A) 
Version 36 – 01.06.2023 

RELEASE NOTES 
VibroSight® 7.3.0 

55 / 81 
 

 
Table 1: VibroSight software and VM600Mk2 MPC4Mk2 firmware compatibility 

for later standard versions of the MPC4Mk2 (PNRs 601-041 / 600-041-001-002 and 600-041-000-002) 

 VM600Mk2 MPC4Mk2 firmware 

VibroSight software 
version 

Part number (PNR) 

Machinery protection firmware (640-025-vvv-ppp.Mpc4g2Fw) 

640-025- 

004-000 

640-025- 

004-003 

640-025- 

005-000 

640-025- 

006-000 

640-025- 

007-001 

640-025- 

008-000 

Condition monitoring firmware (640-033-vvv-ppp.VxeFw) 

--- --- 640-033- 

001-000 

640-033- 

002-000 

640-033- 

003-000 

640-033- 

004-000 

Recovery firmware (640-031-vvv-ppp.Mpc4g2Fw) 

640-031- 

003-004 

640-031- 

003-006 

640-031- 

005-001 

640-031- 

006-000 

Proof test firmware (640-032-vvv-ppp.VxeFw) 

640-032- 

001-000 

640-032- 

001-001 

640-032- 

003-000 

640-032- 

004-000 

6.0.0 
609-004-000-050 

 
     

6.1.0 
609-004-000-051 

 See note 1   
   

7.0.0 
609-010-000-001 

  See note 2a  See note 2b 
   

7.1.0 
609-010-000-001 

    See note 3 
  

7.2.0 
609-010-000-001 

     See note 4 
 

7.3.0 
609-010-000-001 

      See note 5 

 

Notes for Table 1 (see the next page) 
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Notes for Table 1 
1. This version of VM600Mk2 MPC4Mk2 firmware improves frequency domain measurements (the phase component can be used as the input 
signal for an analog output), differential expansion (dual taper) processing (the ramp angles for the taper on the shaft are configured separately), 
auxiliary input channels configured as tacho inputs (appropriate data quality indicators and warning messages, with automatic recovery), and 
the maximum tacho speed / frequency has been increased. It also includes a number of bug fixes. (Refer to the VibroSight 6.1 release notes for 
further information.) A firmware upgrade is required in order to run VibroSight 6.1.0 or later. 
 
2a. For information on these versions of VM600Mk2 MPC4Mk2 firmware, refer to the VibroSight 7.0 release notes. 
A firmware upgrade is required in order to run VibroSight 7.0.0 or later. 
 

2b. For information on these versions of VM600Mk2 MPC4Mk2 firmware, refer to the VibroSight 7.0 release notes. 
A firmware upgrade is required in order to run VibroSight 7.0.0 or later. 
 
3. For information on these versions of VM600Mk2 MPC4Mk2 firmware, refer to the VibroSight 7.1 release notes. 
A firmware upgrade is required in order to run VibroSight 7.1.0 or later. 
 
4. For information on these versions of VM600Mk2 MPC4Mk2 firmware, refer to the VibroSight 7.2 release notes. 
A firmware upgrade is required in order to run VibroSight 7.2.0 or later. 
 
5. For information on these versions of VM600Mk2 MPC4Mk2 firmware, see 2.23 MPC4Mk2 + IOC4Mk2 module – firmware. See also 
2.22 MPC4Mk2 + IOC4Mk2 module – hardware (standard and SIL versions). 
A firmware upgrade is required in order to run VibroSight 7.3.0 or later. 
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Table 2: VibroSight software and VM600Mk2 MPC4Mk2 firmware compatibility 

for the original standard version of MPC4Mk2 (PNRs 601-041 / 600-041-000-001) – no longer supported 

 VM600Mk2 MPC4Mk2 firmware 

VibroSight software 
version 

Part number (PNR) 

Machinery protection firmware (640-025-vvv-ppp.Mpc4g2Fw) 

640-025- 

003-002 

640-025- 

004-000 

640-025- 

004-003 

640-025- 

005-000 

640-025- 

006-000 

Condition monitoring firmware (640-033-vvv-ppp.VxeFw) 

--- --- --- 640-033- 

001-000 

640-033- 

002-000 

Recovery firmware (640-031-vvv-ppp.Mpc4g2Fw) 

640-031- 

003-002 

640-031- 

003-004 

640-031- 

003-006 

Proof test firmware (640-032-vvv-ppp.VxeFw) 

640-032- 

001-000 

640-032- 

001-001 

6.0.0 
609-004-000-050 

 See note 1  
   

6.1.0 
609-004-000-051 

  See note 2   
 

7.0.0 
609-010-000-001 

   See note 3a  See note 3b 
 

7.1.0 
609-010-000-001 

     See note 4 

 

Notes for Table 2 (see the next page) 
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Notes for Table 2 
1. This version of VM600Mk2 MPC4Mk2 (previously referred to as VM600 MPC4G2) firmware is the official launch release of firmware supporting 
VibroSight Protect and VM600Mk2 systems. A firmware upgrade is required in order to run VibroSight 6.0.0 or later – that is, to use VM600Mk2 
systems in “live” machinery protection system (MPS) applications. Contact Meggitt SA for further information. 
 

2. This version of VM600Mk2 MPC4Mk2 firmware improves frequency domain measurements (the phase component can be used as the input 
signal for an analog output), differential expansion (dual taper) processing (the ramp angles for the taper on the shaft are configured separately), 
auxiliary input channels configured as tacho inputs (appropriate data quality indicators and warning messages, with automatic recovery), and 
the maximum tacho speed / frequency has been increased. It also includes a number of bug fixes. (Refer to the VibroSight 6.1 release notes for 
further information.) A firmware upgrade is required in order to run VibroSight 6.1.0 or later. 
 
3a. For information on these versions of VM600Mk2 MPC4Mk2 firmware, refer to the VibroSight 7.0 release notes. 
A firmware upgrade is required in order to run VibroSight 7.0.0 or later. 
 

3b. For information on these versions of VM600Mk2 MPC4Mk2 firmware, refer to the VibroSight 7.0 release notes. 
A firmware upgrade is required in order to run VibroSight 7.0.0 or later. 
 

4. For information on these versions of VM600Mk2 MPC4Mk2 firmware, refer to the VibroSight 7.1 release notes. 
A firmware upgrade is required in order to run VibroSight 7.1.0. 
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Table 3: VibroSight software and VM600Mk2 MPC4Mk2 SIL firmware compatibility 

for the SIL version of the MPC4Mk2 (PNRs 601-040 / 600-040-vvv-vvv) 

 VM600Mk2 MPC4Mk2 SIL firmware 

VibroSight software version 

Part number (PNR) 

SIL machinery protection firmware 
(640-024-vvv-ppp.SafeMpc4g2Fw) 

640-024-001T005 

Condition monitoring firmware 
(640-033-vvv-ppp.VxeFw) 

640-033-004-000 

SIL recovery firmware  
(640-026-vvv-ppp.SafeMpc4g2Fw) 

640-026-001-000 

Proof test firmware 
(640-032-vvv-ppp.VxeFw) 

640-032-004-000 

7.3.0 
609-010-000-001 

 

 

Notes for Table 3 
 
1. For information on these versions of VM600Mk2 MPC4Mk2 SIL firmware, see 2.24 MPC4Mk2 + IOC4Mk2 SIL module – firmware and 
2.23 MPC4Mk2 + IOC4Mk2 module – firmware. See also 2.22 MPC4Mk2 + IOC4Mk2 module – hardware (standard and SIL versions). 
A firmware upgrade is required in order to run VibroSight 7.3.0 or later. 
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Table 4: VibroSight software and VM600Mk2 CPUMMk2 firmware compatibility 

 VM600Mk2 CPUMMk2 firmware  See note 1 

VibroSight software 
version 

Part number (PNR) 

Base-system / Applications firmware (*.tgz) 

640-034- 

001-000 

640-034- 

001-001 

640-034- 

002-000 

640-034- 

003-000 

640-034- 

003-001 

6.1.0 
609-004-000-051 

 See note 2   
  

7.0.0 
609-010-000-001 

  See note 3  
  

7.1.0 
609-010-000-001 

   See note 4  
 

7.2.0 
609-010-000-001 

    See note 5 
 

7.3.0 
609-010-000-001 

     See note 6 

 

Notes for Table 4 
1. VM600 CPUR2 firmware is packaged and distributed as a .tgz file (a compressed archive file format) with PNRs such as 640-034-001-xxx for 
the base system firmware. In these PNRs, the xxx-xxx-001-xxx denotes the firmware is packaged in the tgz file format. 

After the .tgz file is unpacked by VibroSight System Manager and the firmware is uploaded to a VM600 CPUMMk2 module, the dialog box 
displayed by the VibroSight System Manager’s Change Firmware command shows the current version of firmware using PNRs such as 640-
034-000-xxx for the base system firmware, which correspond to the actual unpacked firmware that is running on the module. 
 

2. This version of VM600Mk2 CPUMMk2 firmware is the official launch release of firmware supporting VM600Mk2 systems. (Refer to the 
VibroSight 6.1 release notes for further information.) A firmware upgrade is required in order to run VibroSight 6.1.0 or later. 
 

3. For information on this version of VM600Mk2 CPUMMk2 firmware, refer to the VibroSight 7.0 release notes. 
A firmware upgrade is required in order to run VibroSight 7.0.0 or later. 
 

4. For information on this version of VM600Mk2 CPUMMk2 firmware, refer to the VibroSight 7.1 release notes. 
A firmware upgrade is required in order to run VibroSight 7.1.0 or later. 
 

5. For information on this version of VM600Mk2 CPUMMk2 firmware, refer to the VibroSight 7.2 release notes. 
A firmware upgrade is required in order to run VibroSight 7.2.0 or later. 
 

6. For information on this version of VM600Mk2 CPUMMk2 firmware, see 2.25 CPUMMk2 + IOCNMk2 . 
A firmware upgrade is not required but is strongly recommended in order to run VibroSight 7.3.0 or later. 
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Table 5: VibroSight software and VM600 CPUR2 firmware compatibility 

 VM600 CPUR2 firmware  See note 1 

VibroSight software 
version 

Part number (PNR) 

Base-system firmware (*.tgz) 

640-014- 

001-001 

640-014- 

001-002 

640-014- 

001-003 

640-014-001-

005 

640-014-001-

006 

Applications firmware (*.tgz) 

640-015- 

001-001 

640-015- 

001-002 

640-015- 

001-003 

640-015- 

001-005 

640-015- 

001-006 

4.0.0 
609-004-000-046 

 See note 2  See note 3   
 

4.1.0 
609-004-000-047 

   See note 4  
 

5.0.0 
609-004-000-048 

    
 

5.1.0 
609-004-000-049 

    
 

6.0.0 
609-004-000-050 

    
 

6.1.0 
609-004-000-051 

    
 

7.0.0 
609-010-000-001 

    See note 5 
 

7.1.0 
609-010-000-001 

     See note 6 

7.2.0 
609-010-000-001 

     

7.3.0 
609-010-000-001 

     

 

Notes for Table 5 (see the next page)  
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Notes for Table 5 
1. VM600 CPUR2 firmware is packaged and distributed as a .tgz file (a compressed archive file format) with PNRs such as 640-014-001-xxx for 
the Base System and 640-015-001-xxx for the (Applications) Firmware. In these PNRs, the xxx-xxx-001-xxx denotes the firmware is packaged 
in the tgz file format. 

After the .tgz file is unpacked by VibroSight System Manager and the firmware is uploaded to a VM600 CPUR2 card, the dialog box displayed 
by the VibroSight System Manager’s Change Firmware command shows the current version of firmware using PNRs such as 640-014-000-xxx 
for the Base System and 640-015-000-xxx for the Firmware, which correspond to the actual unpacked firmware that is running on the card. 
 

2. This is the first official release of VM600 CPUR2 firmware and includes features such as the management of XMx16 card configurations for 
applications such as control systems and the implementation of the PROFIBUS protocol for the fieldbus interfaces. A firmware upgrade is 
required in order to run VibroSight 2.12.7 or later. 
 

3. This version of VM600 CPUR2 firmware includes improvements such as changing the PROFIBUS polling rate for the Modbus server to 
100 ms (was 200 ms) and a bug fix for a known VM600 CPUx time counter wraparound (overflow) issue. A firmware upgrade is strongly 
recommended in order to run VibroSight 3.4.0 or later. 
 

4. This version of VM600 CPUR2 firmware includes improvements such as overall performance, responsiveness and stability, and support for 
CPUR2/IOCR2 card pair relays, and the ability to download the GSD file directly from the card. A firmware upgrade is strongly recommended 
but is not required in order to run VibroSight 4.1.0 or later. 
Note: VibroSight 4.1.0 or later must be used in order to download the VM600 CPUR2 GSD file directly from the CPUR2 card. 
 

5. For information on this version of VM600Mk2 CPUR2 firmware, refer to the VibroSight 7.0 release notes. 
A firmware upgrade is required in order to run VibroSight 7.0.0 or later. 
 

6. For information on this version of VM600Mk2 CPUR2 firmware, refer to the VibroSight 7.0 release notes. 
A firmware upgrade is required in order to run VibroSight 7.1.0 or later. 
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Table 6: VibroSight software and VM600 CPUR firmware compatibility 

 VM600 CPUR firmware  See note 1 

VibroSight software version 

Part number (PNR) 

Base-system firmware (*.tgz) 

640-011-001-004 640-011-001-005 

Applications firmware (*.tgz) 

640-012-001-004 640-012-001-005 

4.0.0 
609-004-000-046 

 See note 2  

4.1.0 
609-004-000-047 

  See note 3 

5.0.0 
609-004-000-048 

  

5.1.0 
609-004-000-049 

  

6.0.0 
609-004-000-050 

  

6.1.0 
609-004-000-051 

  

7.0.0 
609-010-000-001 

  

7.1.0 
609-010-000-001 

  

7.2.0 
609-010-000-001 

  

7.3.0 
609-010-000-001 

  

 

Notes for Table 6 (see the next page)  



 

RELEASE NOTES 
VibroSight® 7.3.0 
64 / 81 

Document reference VIBROSIGHT-RN/E (660-010-013-236A) 
Version 36 – 01.06.2023 

 

Notes for Table 6 
1. VM600 CPUR firmware is packaged and distributed as a .tgz file (a compressed archive file format) with PNRs such as 640-011-001-xxx for 
the Base System and 640-012-001-xxx for the (Applications) Firmware. In these PNRs, the xxx-xxx-001-xxx denotes the firmware is packaged 
in the tgz file format. 

After the .tgz file is unpacked by VibroSight System Manager and the firmware is uploaded to a VM600 CPUR card, the dialog box displayed by 
the VibroSight System Manager’s Change Firmware command shows the current version of firmware using PNRs such as 640-011-000-xxx for 
the Base System and 640-012-000-xxx for the Firmware, which correspond to the actual unpacked firmware that is running on the card. 
 

2. This is the latest official release of VM600 CPUR firmware (that is, the earlier version of the CPUx card with support for card pair redundancy 
(PNR 600-007-000-vvv)), which was discontinued in VibroSight 2.12.0 and reintroduced in VibroSight 4.0.x). 
 
3. This version of VM600 CPUR firmware includes a bug fix for a known VM600 CPUx time counter wraparound (overflow) issue and the 
addition of relay outputs to the diagnostics logs. A firmware upgrade is strongly recommended but is not required in order to run VibroSight 4.1.0 
or later. 
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Table 7: VibroSight software and VM600 XMx16 firmware compatibility 

 VM600 XMx16 firmware  See note 1 

VibroSight software version 

Part number (PNR) 

Base-system firmware (*.tgz) 

640-003-001-016 

Applications firmware (*.tgz) 

640-010-001-016 

4.0.0 
609-004-000-046 

 See note 2 

4.1.0 
609-004-000-047 

 

5.0.0 
609-004-000-048 

 

5.1.0 
609-004-000-049 

 

6.0.0 
609-004-000-050 

 

6.1.0 
609-004-000-051 

 

7.0.0 
609-010-000-001 

 

7.1.0 
609-010-000-001 

 

7.2.0 
609-010-000-001 

 

7.3.0 
609-010-000-001 

 

 

Notes for Table 7 (see the next page)  
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Notes for Table 7 
1. VM600 XMx16 firmware is packaged and distributed as a .tgz file (a compressed archive file format) with PNRs such as 640-003-001-xxx for 
the Base System and 640-010-001-xxx for the (Applications) Firmware. In these PNRs, the xxx-xxx-001-xxx denotes the firmware is packaged 
in the tgz file format. 

After the .tgz file is unpacked by VibroSight System Manager and the firmware is uploaded to a VM600 XMx16 card, the dialog box displayed by 
the VibroSight System Manager’s Change Firmware command shows the current version of firmware using PNRs such as 640-010-000-xxx for 
the Firmware and 640-003-000-xxx for the Base System, which correspond to the actual unpacked firmware that is running on the card. 
 

2. This version of VM600 XMx16 firmware includes relaxed constraints for dynamic data retention time, that is, optimised memory to reduce the 
possibility of missing data in data intensive VibroSight applications running on less powerful computers. A firmware upgrade is required in order 
to run VibroSight 3.3.0 or later. 
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7.2.2 VibroSmart device firmware 

The latest VibroSmart device firmware files are copied to a directory on your computer as part of the VibroSight 
software installation process. 

NOTE: The default firmware directory for VibroSmart devices is: 
C:\Program Files\Meggitt\VibroSight\Firmware\VibroSmart 

 

The firmware files for a VibroSmart device can be found in the appropriate subfolder and identified by their .*fw 
file name extension. For example, the VSV30x subfolder contains the firmware for use by VSV30x modules. Any 
additional firmware updates received from Meggitt SA should also be stored in these directories. 

Table 8 shows the compatibility between VibroSight software and the VibroSmart VSI010 firmware. 

Table 9 shows the compatibility between VibroSight software and the VibroSmart VSN010 firmware. 

Table 10 shows the compatibility between VibroSight software and the VibroSmart VSV30x firmware. 

 

NOTE: It is strongly recommended to use the most recent version of the VibroSmart 
firmware that is compatible with the version of VibroSight software being used. 
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Table 8: VibroSight software and VibroSmart VSI010 firmware compatibility 

 VSI010 firmware (*.xmsifw)  See note 1 

VibroSight 
software version 

Part number 
(PNR) 

642-002-000-010 642-002-000-011 642-002-000-012 642-002-000-013 642-002-000-014 

5.0.0 
609-004-000-048 

See notes 

2 and 3 
See notes 

2 and 4 
See notes 

2 and 5 
 

 

5.1.0 
609-004-000-049 

    
 

6.0.0 
609-004-000-050 

   
  

6.1.0 
609-004-000-051 

   
See notes 

2 and 6 

 

7.0.0 
609-010-000-001 

    
 

7.1.0 
609-010-000-001 

    
See notes 

2 and 7 

7.2.0 
609-010-000-001 

     

7.3.0 
609-010-000-001 

     

 

Notes for Table 8 (see the next page)  
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Notes for Table 8 
1. VibroSmart VSI010 firmware is distributed as a single .xmsifw file (a proprietary file format) with a PNR such as 642-xxx-000-xxx. In these 
PNRs, the xxx-xxx-000-xxx denotes that the firmware is not packaged (compressed or archived). VibroSight System Manager always uses and 
displays information about VibroSmart device firmware using PNRs such as 642-xxx-000-xxx, which correspond to the actual firmware that is 
running on the device. 
 

2. Updating to this version of VibroSmart VSI010 firmware requires a specific process: 

Notes: For a VibroSmart consisting of different types of device, the devices should be updated in the following order: first VSN010 real-time 
Ethernet switches, then VSV30x vibration monitoring modules and finally VSI010 communications interface modules. In addition, VibroSight 
System Manager should be exited (closed) and restarted after updating the firmware for each type of device, before continuing. And after 
updating the firmware, the configuration on the VibroSmart devices should be re-applied (re-activated) and the VibroSmart devices should be 
restarted. 

Procedure: 

(1) Ensure that a copy of the configuration for the VibroSmart is available before updating any device firmware. For example, using the currently 
installed version of VibroSight (that is, before any updates to the VibroSight software corresponding to updates to VibroSmart devices), 
VibroSight Configurator can be used to obtain a copy of the configuration as follows: 
• For a VibroSmart using a VibroSight Server, the File > Open > Server / Database command can be used to read the configuration from the 
VibroSight Server. 
• For a VibroSmart not using a VibroSight Server (that is, a “stand-alone” VibroSmart), the File > Open > Device command can be used to read 
the configuration directly from the VibroSmart modules. 
Then the File > Save As > File command can be used to store a copy of the configuration for the VibroSmart. 

(2) Start VibroSight System Manager, select the device or devices of the same type to be updated (for example, VSI010 modules) and run the 
Change Firmware command. 
When updating multiple VibroSmart devices of the same type to use the same firmware, CTRL+click or SHIFT+click can be used to select 
multiple devices in the Devices tree structure of the System Explorer window. This way, when the Change Firmware command is run, all of 
devices that were selected will be updated at the same time. Otherwise, each device must be selected and updated individually. 

(3) When the VibroSmart Module(s) Firmware Upgrade window displays a “Firmware upgrade terminated. The firmware has been upgraded 
successfully …” message, click the Finish button to continue. 
If after 10 minutes, the VibroSmart Module(s) Firmware Upgrade window does not display a successful message, click the Cancel button to 
close the window and continue. 
Then exit (close) VibroSight System Manager. 

(4) Restart VibroSight System Manager and verify that the correct version of firmware is reported for each device that was updated. (When a 
device is selected in the System Explorer window, this information is available in the main window (centre) under Module PNR. It is also 
available in the VibroSmart Module(s) Firmware Upgrade window when a device is selected and the Change Firmware command is run). 
If a device does not report the correct version of firmware, rerun the Change Firmware command for this device. 
Then exit (close) VibroSight System Manager. 

(5) Repeat steps (2), (3) and (4) for each type of device to be updated (for example, VSN010 and VSV30x modules). 

(6) Start VibroSight Configurator, open the configuration for the VibroSmart (see step (1)), then apply (activate) the configuration. (If required, 
VibroSight Configurator will automatically update the configuration to the latest version and inform the user.) 
Then exit (close) VibroSight Configurator. 

(7) Turn the power supply to the VibroSmart off and wait for a few seconds. Then turn the power supply back on and verify that the system 
operates as expected. 

During this firmware update process, the behaviour of the LEDs on the front panel of the VibroSmart devices can be inconsistent and should be 
ignored. Normal LED behaviour resumes after the firmware update is complete (after step (7)). 
 

3. This version of VibroSmart VSI010 firmware has no limit on the number of constants per VSI010 module. 
A firmware upgrade is recommended but is not required in order to run VibroSight 3.8.0 or later. 

4. This version of VibroSmart VSI010 firmware adds support for Modbus function code 03. 
A firmware upgrade is required in order to run VibroSight 5.0.0 or later. 

5. This version of VibroSmart VSI010 firmware adds support for module lock and the GOOSE communications protocol (IEC 61850). 
A firmware upgrade is required in order to run VibroSight 5.0.0 or later. 

6. For information on this version of VibroSmart VSI010 firmware, refer to the VibroSight 6.1 release notes. 
A firmware upgrade is required in order to run VibroSight 6.1.0 or later. 

7. For information on this version of VibroSmart VSI010 firmware, refer to the VibroSight 7.1 release notes.  
A firmware upgrade is required in order to run VibroSight 7.1.0 or later.  
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Table 9: VibroSight software and VibroSmart VSN010 firmware compatibility 

 VSN010 firmware (*.redboxfw)  See note 1 

VibroSight software version 
Part number (PNR) 

642-004-000-011 642-004-000-012 

5.0.0 
609-004-000-048 

 See note 2 
 

5.1.0 
609-004-000-049 

 
 

6.0.0 
609-004-000-050 

 
 

6.1.0 
609-004-000-051 

 
 

7.0.0 
609-010-000-001 

 
 

7.1.0 
609-010-000-001 

 
See notes 

2 and 3 

7.2.0 
609-010-000-001 

  

7.3.0 
609-010-000-001 

  

 

Notes for Table 9 (see the next page)  
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Notes for Table 9 
1. VibroSmart VSN010 firmware is distributed as a single .redboxfw file (a proprietary file format) with a PNR such as 642-xxx-000-xxx. In these 
PNRs, the xxx-xxx-000-xxx denotes that the firmware is not packaged (compressed or archived). VibroSight System Manager always uses and 
displays information about VibroSmart device firmware using PNRs such as 642-xxx-000-xxx, which correspond to the actual firmware that is 
running on the device. 
 

2. Updating to this version of VibroSmart VSN010 firmware requires a specific process: 

Notes: For a VibroSmart consisting of different types of device, the devices should be updated in the following order: first VSN010 real-time 
Ethernet switches, then VSV30x vibration monitoring modules and finally VSI010 communications interface modules. In addition, VibroSight 
System Manager should be exited (closed) and restarted after updating the firmware for each type of device, before continuing. And after 
updating the firmware, the configuration on the VibroSmart devices should be re-applied (re-activated) and the VibroSmart devices should be 
restarted. 

Procedure: 

(1) Ensure that a copy of the configuration for the VibroSmart is available before updating any device firmware. For example, using the currently 
installed version of VibroSight (that is, before any updates to the VibroSight software corresponding to updates to VibroSmart devices), 
VibroSight Configurator can be used to obtain a copy of the configuration as follows: 
• For a VibroSmart using a VibroSight Server, the File > Open > Server / Database command can be used to read the configuration from the 
VibroSight Server. 
• For a VibroSmart not using a VibroSight Server (that is, a “stand-alone” VibroSmart), the File > Open > Device command can be used to read 
the configuration directly from the VibroSmart modules. 
Then the File > Save As > File command can be used to store a copy of the configuration for the VibroSmart. 

 (2) Start VibroSight System Manager, select the device or devices of the same type to be updated (for example, VSN010 modules) and run the 
Change Firmware command. 
When updating multiple VibroSmart devices of the same type to use the same firmware, CTRL+click or SHIFT+click can be used to select 
multiple devices in the Devices tree structure of the System Explorer window. This way, when the Change Firmware command is run, all of 
devices that were selected will be updated at the same time. Otherwise, each device must be selected and updated individually. 

(3) When the VibroSmart Module(s) Firmware Upgrade window displays a “Firmware upgrade terminated. The firmware has been upgraded 
successfully …” message, click the Finish button to continue. 
If after 10 minutes, the VibroSmart Module(s) Firmware Upgrade window does not display a successful message, click the Cancel button to 
close the window and continue. 
Then exit (close) VibroSight System Manager. 

(4) Restart VibroSight System Manager and verify that the correct version of firmware is reported for each device that was updated. (When a 
device is selected in the System Explorer window, this information is available in the main window (centre) under Module PNR. It is also 
available in the VibroSmart Module(s) Firmware Upgrade window when a device is selected and the Change Firmware command is run). 
If a device does not report the correct version of firmware, rerun the Change Firmware command for this device. 
Then exit (close) VibroSight System Manager. 

(5) Repeat steps (2), (3) and (4) for each type of device to be updated (for example, VSI010 and VSV30x modules). 

(6) Start VibroSight Configurator, open the configuration for the VibroSmart (see step (1)), then apply (activate) the configuration. (If required, 
VibroSight Configurator will automatically update the configuration to the latest version and inform the user.) 
Then exit (close) VibroSight Configurator. 

(7) Turn the power supply to the VibroSmart off and wait for a few seconds. Then turn the power supply back on and verify that the system 
operates as expected. 

During this firmware update process, the behaviour of the LEDs on the front panel of the VibroSmart devices can be inconsistent and should be 
ignored. Normal LED behaviour resumes after the firmware update is complete (after step (7)). 
 

3. For information on this version of VibroSmart VSN010 firmware, refer to the VibroSight 7.1 release notes.  
A firmware upgrade is required in order to run VibroSight 7.1.0 or later. 
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Table 10: VibroSight software and VibroSmart VSV30x firmware compatibility 

 VSV30x firmware (*.xtranfw)  See note 1 

VibroSight 
software version 

Part number 
(PNR) 

642-001-000-017 642-001-000-018 

642-001-000- 

000DEV_ 

SVN14937_ 

2020-05-20 

642-001-000-019 642-001-000-020 

5.0.0 
609-004-000-048 

See notes 

2 and 3 
See notes 

2 and 4 

   

5.1.0 
609-004-000-049 

  
See notes 

2 and 5 
 

 

6.0.0 
609-004-000-050 

   
  

6.1.0 
609-004-000-051 

   
See notes 

2 and 6 

 

7.0.0 
609-010-000-001 

    
 

7.1.0 
609-010-000-001 

    
See notes 

2 and 7 

7.2.0 
609-010-000-001 

     

7.3.0 
609-010-000-001 

     

 

Notes for Table 10 (see the next page)  
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Notes for Table 10 
1. VibroSmart VSV30x firmware is distributed as a single .xtranfw file (a proprietary file format) with a PNR such as 642-xxx-000-xxx. In these 
PNRs, the xxx-xxx-000-xxx denotes that the firmware is not packaged (compressed or archived). VibroSight System Manager always uses and 
displays information about VibroSmart device firmware using PNRs such as 642-xxx-000-xxx, which correspond to the actual firmware that is 
running on the device. 
 

2. Updating to this version of VibroSmart VSV30x firmware requires a specific process: 

Notes: For a VibroSmart consisting of different types of device, the devices should be updated in the following order: first VSN010 real-time 
Ethernet switches, then VSV30x vibration monitoring modules and finally VSI010 communications interface modules. In addition, VibroSight 
System Manager should be exited (closed) and restarted after updating the firmware for each type of device, before continuing. And after 
updating the firmware, the configuration on the VibroSmart devices should be re-applied (re-activated) and the VibroSmart devices should be 
restarted. 

Procedure: 

(1) Ensure that a copy of the configuration for the VibroSmart is available before updating any device firmware. For example, using the currently 
installed version of VibroSight (that is, before any updates to the VibroSight software corresponding to updates to VibroSmart devices), 
VibroSight Configurator can be used to obtain a copy of the configuration as follows: 
• For a VibroSmart using a VibroSight Server, the File > Open > Server / Database command can be used to read the configuration from the 
VibroSight Server. 
• For a VibroSmart not using a VibroSight Server (that is, a “stand-alone” VibroSmart), the File > Open > Device command can be used to read 
the configuration directly from the VibroSmart modules. 
Then the File > Save As > File command can be used to store a copy of the configuration for the VibroSmart. 
(2) Start VibroSight System Manager, select the device or devices of the same type to be updated (for example, VSV30x modules) and run the 
Change Firmware command. 
When updating multiple VibroSmart devices of the same type to use the same firmware, CTRL+click or SHIFT+click can be used to select 
multiple devices in the Devices tree structure of the System Explorer window. This way, when the Change Firmware command is run, all of 
devices that were selected will be updated at the same time. Otherwise, each device must be selected and updated individually. 
(3) When the VibroSmart Module(s) Firmware Upgrade window displays a “Firmware upgrade terminated. The firmware has been upgraded 
successfully …” message, click the Finish button to continue. 
If after 10 minutes, the VibroSmart Module(s) Firmware Upgrade window does not display a successful message, click the Cancel button to 
close the window and continue. 
Then exit (close) VibroSight System Manager. 
(4) Restart VibroSight System Manager and verify that the correct version of firmware is reported for each device that was updated. (When a 
device is selected in the System Explorer window, this information is available in the main window (centre) under Module PNR. It is also 
available in the VibroSmart Module(s) Firmware Upgrade window when a device is selected and the Change Firmware command is run). 
If a device does not report the correct version of firmware, rerun the Change Firmware command for this device. 
Then exit (close) VibroSight System Manager. 
(5) Repeat steps (2), (3) and (4) for each type of device to be updated (for example, VSI010 and VSN010 modules). 
(6) Start VibroSight Configurator, open the configuration for the VibroSmart (see step (1)), then apply (activate) the configuration. (If required, 
VibroSight Configurator will automatically update the configuration to the latest version and inform the user.) 
Then exit (close) VibroSight Configurator. 
(7) Turn the power supply to the VibroSmart off and wait for a few seconds. Then turn the power supply back on and verify that the system 
operates as expected. 
During this firmware update process, the behaviour of the LEDs on the front panel of the VibroSmart devices can be inconsistent and should be 
ignored. Normal LED behaviour resumes after the firmware update is complete (after step (7)). 
 

3. This version of VibroSmart VSV30x firmware adds support for configurable tacho ratios, flexible input channel to processing block mapping, 
and up to two tacho processing blocks. A firmware upgrade is required in order to run VibroSight 5.0.0 or later. 

4. This version of VibroSmart VSV30x firmware adds support for module lock, PTP (precision time protocol) time synchronisation, channel 
bypass and pre-trigger data logging. A firmware upgrade is required in order to run VibroSight 5.0.0 or later. 

5. This version of VibroSmart VSV30x firmware improves support for hydro air-gap and magnetic-flux monitoring with a minor bug fix. 
A firmware upgrade is required in order to run VibroSight 5.1.0 or later. 

6. For information on this version of VibroSmart VSV30x firmware, refer to the VibroSight 6.1 release notes. 
A firmware upgrade is required in order to run VibroSight 6.1.0 or later. 

7. For information on this version of VibroSmart VSV30x firmware, refer to the VibroSight 7.1 release notes.  
A firmware upgrade is required in order to run VibroSight 7.1.0 or later. 
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7.2.3 Updating the firmware using VibroSight System Manager 

When performing VibroSight software upgrades, it is strongly recommended to systematically upgrade the firmware 
of VM600Mk2/VM600 and/or VibroSmart modules/devices to the latest compatible version. 

Failure to perform a necessary VibroSight-compatible VM600Mk2/VM600 and/or VibroSmart modules/devices 
firmware update may lead to incoherent system behaviour and affect the proper functioning of data acquisition in a 
system. It is only in systems where the firmware running on the VM600Mk2/VM600 and/or VibroSmart 
modules/devices already corresponds to the latest available version that no firmware update is required. Therefore, 
it is strongly recommended to verify the version of firmware running on the hardware before starting a VibroSight 
system upgrade, in order to establish if a firmware update is also required. 

NOTE: Updating the firmware for VM600Mk2/VM600 and/or VibroSmart modules/devices is 
a special task that can, if used unintentionally or incorrectly, lead to malfunctioning 
of the device and affect proper function of data acquisition. It is therefore strongly 
recommended to change the firmware of VibroSight-compatible hardware only 
when it is necessary. For example, when the devices must be updated to be 
compatible with a VibroSight software upgrade. 

During the firmware update of a device, the module or card being updated cannot 
provide its normal machinery monitoring functions because its outputs (alarms and 
relays) can go to undetermined states, irrespective of how they have been 
configured. 

 

NOTE: It is highly recommended that firmware updates are only performed in accordance 
with the operating procedures for the machinery being monitored and that 
appropriate precautions are taken at the control system level (such as DCS 
or PLC). 

For example, alarms and relay outputs should be ignored (bypassed or inhibited) in 
order to avoid false trips of the machinery being monitored. 

 

For VibroSmart modules, each module can be selected and its firmware updated individually. Alternatively, multiple 
modules of the same type (for example, VSV3x0) can be updated to the same version of firmware at the same 
time. 

NOTE: It is strongly recommended to ensure that a copy of the configuration for a 
VibroSmart is available before updating the firmware of any of the VibroSmart 
modules used in the distributed monitoring system. 

For example, using the currently installed version of VibroSight (that is, before any 
updates to the VibroSight software corresponding to updates to VibroSmart 
modules), VibroSight Configurator should be used to obtain a copy of the 
configuration as follows:  

For a VibroSmart using a VibroSight Server, the File > Open > Server / Database 
command can be used to read the configuration from the VibroSight Server. 
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For a VibroSmart not using a VibroSight Server (that is, a “stand-alone” 
VibroSmart), the File > Open > Device command can be used to read the 
configuration directly from the VibroSmart modules. 

Then the File > Save As > File command should be used to store a copy of the 
configuration for the VibroSmart distributed monitoring system. 

 

Update the firmware on a VibroSight device using the  Change Firmware tool (from VibroSight System 
Manager’s Maintenance tools): 

1. Ensure that the computer running the VibroSight software is on the same network as the hardware 
(VM600Mk2/VM600 and/or VibroSmart modules/devices) to be updated. 

2. Start VibroSight System Manager and navigate to the Devices tree structure in the System Explorer window. 

The Devices tree lists all of the VibroSight compatible hardware that VibroSight can see on the network. If 
there are no VM600Mk2/VM600 and/or VibroSmart modules/devices in the tree structure or some are missing, 
verify your network connections. 

3. Select the module or device that requires its firmware to be changed. 

The Actions tool window updates to show the available tools. 

To change multiple VibroSmart to use the same version of firmware at the same time, use CTRL+click or 
SHIFT+click to select multiple devices from the Devices tree-view. (Then, when the Change Firmware 
command is run, all of the devices that were selected will be updated at the same time.) 

4. Click  Change Firmware in the Maintenance tools group of the Actions window. 

The Change Firmware dialog box appears. 

5. Click the Add button and select the new firmware files for the card or new firmware file for the device. 

 NOTE: The Change Firmware dialog box automatically opens the firmware folder 
corresponding to the VM600Mk2/VM600 or VibroSmart modules/devices selected. 

 

6. Click the Finish button to start the firmware upgrade process. 

For XMx16 cards and VibroSmart devices, the firmware upgrade process can take up to 5 minutes, during 
which: 

• The IP address beside the device’s serial number in the Devices tree structure can disappear. 

• The LEDs on the front panel of the device can change to reflect the status of the upgrade. 

7. Repeat steps 3 to 6 for each device that requires a firmware update. 

 NOTE: Although the firmware for each VibroSight device must be changed individually 

using the  Change Firmware tool, as each device updates its firmware 
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independently of the VibroSight software (once the process has started), firmware 
updates can be performed on several devices in parallel. 

 

8. After the firmware upgrade, verify that the VibroSight system is acquiring data from the cards. 

 NOTE: Refer also to the Changing the firmware topics in the  VibroSight help. 

 

The  Change Firmware tool can be used to load a VibroSight device with any version of firmware. It is 
therefore possible to change a device’s firmware to any previously available version, as well as the latest update. 

This feature can be useful in certain situations, for example, swapping spare VibroSight hardware between different 
VM600 racks or VibroSmart distributed monitoring systems, where systems are operating with different versions of 
VibroSight. 

 

 

7.3 Final checks 

After upgrading the VibroSight software, it is recommended to check that VibroSight has not been inadvertently 
modified and that it continues to operate normally. 

 

In particular, it is recommended to check any VibroSight Servers in order to ensure that the data acquisition and 
external interfaces, data post-processing and/or logging are all configured as expected. 

 

In a VibroSight Server user interface: 

• On the Status tab under Device drivers, check that the VM600, VibroSmart, OPC and Modbus controls are 
enabled or disabled as required by your application. 

• On the Status tab under Server features, check that the Basic math, Air gap, Combustion monitoring, Duration 
counters, VSHDA import and Data logging manager controls are enabled or disabled as required by your 
application. 

• On the Log messages tab, check the listed messages (Info level) to ensure that the hardware 
(VM600Mk2/VM600 modules/cards and /or VibroSmart modules) have been discovered and that data acquisition 
has resumed. 
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NOTE: When a VibroSight Server is running as a Windows service, the usual VibroSight 
Server user interface is not displayed, so VibroSight System Manager must be 
used to work with the VibroSight Server. 

That is, VibroSight System Manager can be used to connect to a VibroSight Server 
in order to check and configure the operation of the server’s drivers and features. 

 

Finally, after an upgrade, it is strongly recommended to use VibroSight Vision to connect to any VibroSight Servers 
in order to verify that new live and/or historical data is available. 
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8 Customer support 

8.1 Contacting us 

Meggitt SA worldwide customer support network offers a range of support including Technical support and Sales 
and repairs support. For customer support, please contact your local Meggitt representative. Alternatively, contact 
our main office: 

Customer support  
Meggitt SA 

Route de Moncor 4 
Case postale 
1701 Fribourg 
Switzerland 

 

Telephone: +41 (0) 26 407 11 11 
Email: energysupport@ch.meggitt.com 

Website: www.meggittsensing.com/energy 

 

8.2 Technical support 

Meggitt SA technical support team provide both pre-sales and post-sales technical support, including: 

• General advice 

• Technical advice 

• Troubleshooting 

• Site visits. 

 

8.3 Sales and repairs support 

Meggitt SA sales team provide both pre-sales and post-sales support, including advice on: 

• New products 

• Spare parts 

• Repairs. 

 

 

mailto:energysupport@ch.meggitt.com
http://www.meggittsensing.com/energy
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VibroSight software and Windows® operating system compatibility 

 

 
Windows 11 Windows 10 Windows 8.1 

VibroSight software compatible? Yes Yes 

Yes 
but not recommended for new 

installations as Microsoft mainstream 
support ended in 2018 

(extended support will end in 2023) 

 

 

VibroSight software and Windows® Server operating system compatibility 

 

 
Windows Server 2022 Windows Server 2016 Windows Server 2012 

VibroSight software compatible? Yes Yes 

Yes 
but not recommended for new 

installations as Microsoft mainstream 
support ended in 2018 

(extended support will end in 2023) 
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VibroSight software and Microsoft® .NET Framework requirements 

VibroSight software version Microsoft .NET Framework requirements 

VibroSight 3.7.0 or later .NET Framework 4.7.2 See note 1 

VibroSight 3.4.0 or later .NET Framework 4.7.1 See note 2 

VibroSight 3.0.0 or later .NET Framework 4.6 

VibroSight 2.12.0 or later .NET Framework 4.5 and .NET Framework 2.0 See note 3 

VibroSight 2.9.4 or later .NET Framework 4.5 

VibroSight 2.9.3 and 2.9.2 .NET Framework 4 (Standalone Installer) 

VibroSight 2.9.1 or earlier .NET Framework 3.5 SP1 
 

Notes 

1. Microsoft .NET Framework 4.7.2 replaces .NET Framework versions 4.0 to 4.7.1. 

2. Microsoft .NET Framework 4.7.1 replaces .NET Framework versions 4.0 to 4.7. 

3. Since Microsoft .NET Framework 3.5 also includes .NET Framework 2.0 and .NET Framework 3.0, installing Microsoft .NET Framework 3.5 SP1 is the recommended solution for most computers (rather than 

installing Microsoft .NET Framework 2.0). 
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